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1 Introduction

This is the administrator’s guide for Vizrt’s  for NLE systems.Graphics Plugin

This section contains information on the following topics:

About the Document

Customer Feedback and Suggestions

Customer Support Requests

1.1 About the Document

This manual covers the information needed in order to install and configure the Graphics Plugin.

The purpose of this document is to help new Graphics Plugin administrators become familiar with the 

system; to illustrate the installation process, and show the available configuration options.

This section contains information on the following topics:

Document Structure

Related Documents

Conventions

1.1.1 Document Structure

Section 1 introduces the Graphics Plugin and this document.

Section 2 gives an overview of the supported operating systems, new features, software limitations, and 

basic workflows.

Section 3 describes various software, hardware, and network requirements and recommendations 

noteworthy before installing the Graphics Plugin.

Section 4 gives a guide on how to setup the Viz Engine for graphics rendering with the Graphics Plugin. It 

also gives a quick overview of the  installation and use, and also a more in-depth step-Connection Broker

by-step description of how to install, configure, test, and remove the Graphics Plugin for both Apple- and 

Windows-based systems.

Section 5 explains the user interface; general and advanced configuration, and performance testing. In 

most cases these settings are not needed by the average user; however, specific situations may raise the 

need to tune the system. For more information, please contact your local Vizrt representative.

Section 6 gives an in-depth explanation on how to tune the Graphics Plugin.

Section 7 provides an overview of issues that must be considered when designing scenes for the NLE 

workflow. Notes about key, stop points, stretching, embedded video, Transition Logic, and so on are 

included.

Section 8 is a summary of frequently asked questions. This section also covers information on logging and 

how to report technical issues back to Vizrt.
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1.  

1.  
2.  

3.  
4.  

1.1.2 Related Documents

For complementary information, see the following documents:

Easycut Manual: How to install and use the Easycut tailored version of the Graphics Plugin.

Viz Artist User’s Guide: How to create scenes and work with .Transition Logic

Viz Pilot User’s Guide: How to install and use Viz Pilot, and how to create .combination templates

Viz Engine Administrator’s Guide: Contains lists of supported graphics cards.

Template Wizard User’s Guide: How to create and organize templates to be used by Viz Pilot.

Viz Trio User’s Guide: How to install and use the Viz Trio client.

1.1.3 Conventions

The following typographic conventions are used in this document:

Italic is used for non-hyperlink external references, such as related documents, books, or Internet 

pages. Italic is also used to emphasize words.

The color blue is used for references to sections within this document.

Bold refers to GUI components.

Numbered paragraphs are used to indicate tasks that must be carried out.

1.2 Customer Feedback and Suggestions

We encourage suggestions and feedback about our products and documentation.

To give feedback and, or suggestions, please identify your local Vizrt customer support team at www.vizrt.

com.

Click on  (top of page).Contact
The Vizrt office which is nearest to your location will be shown, or select from the list of Vizrt 

offices.

Click on the  button for the office you want.Contact
Complete the required details in the window that opens.

A Vizrt representative will contact you as soon as possible.

1.3 Customer Support Requests

Support Requests are supported by Vizrt if customers have a valid Service Agreement in operation. 

Customers who do not have a Service Agreement and would like to set up a Service Agreement should 

contact their regional sales representative (see ).Customer Feedback and Suggestions

Note:

If this message is for Customer Support, and there is a Support Contract in place, then click on the For 

 link in the message window.support requests, please visit our support portal

......................................................................................................................................................................

......................................................................................................................................................................
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When submitting a Support Request, relevant and correct information should be given to Vizrt Support, to 

make sure that Vizrt Support can give the quickest and best solution to your Support Request.

This section contains information on the following topics:

Before Submitting a Support Request

Submitting a Support Request

1.3.1 Before Submitting a Support Request

Before a Support Request is submitted make sure that you:

Read:

The relevant User Guide or Guides

The release notes

and Check:

That the system is configured correctly

That you have the specified hardware, tested and recommended versions

Always refer to your Vizrt Service Level Agreement document.

1.3.2 Submitting a Support Request

Content of a Support Request

The report should contain information about these topics:

Problem description: Include a good description of what the problem is and how to reproduce it. 

Specify your workflow. Remember to use simple English.

Screenshots and illustrations: Use these to simplify the message. These are extremely useful for 

Vizrt Support.

Software configuration: Add exact versions of software used. This is extremely important 

information.

System log files: Send the system log file.

System locale: Specify the Region and Language settings of the system.

Hardware configuration: Add exact versions of hardware used, especially for Viz Engine.

Optional:

System setup: Describe differences in the installation, if any, from the recommended setup.

System Network: Add a description of how the network, bandwidth, routers, and switches are 

configured.

Note:

When completing a Support Request, add as much information as possible.

......................................................................................................................................................................

......................................................................................................................................................................
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1.  
2.  
3.  
4.  
5.  

6.  

Always refer to your Vizrt Service Level Agreement document.

To submit a Support Request

On the www.vizrt.com page, click on Support.

Click on .Report a case

Click on  to log in to the Customer and Partner portal.LOG IN

At the top of the Case Management page, click on .Report a Case
In the online form complete the required minimum information (shown by a red asterisk) and click 

.SAVE
In the saved Support Case that opens, complete the various text boxes and upload any required 

documents, files, and so on (see ).Content of a Support Request

To  of open support tickets, login to the Customer and Partner portal. Add information or track the status
communicate about the cases directly with the support team.
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2 About the Graphics Plugin

The Graphics Plugin integrates Vizrt’s graphics workflow into the  workflow.Non-Linear Editing (NLE)

Using the Graphics Plugin, NLE system users can continue to follow their normal workflow by accessing 

Vizrt’s control applications within the preferred NLE system, and easily add real-time rendered Vizrt 

graphics while editing video clips.

The Graphics Plugin integrates with a variety of ; Adobe’s Premiere, Apple’s Supported NLE Systems

Final Cut Pro, Avid’s Media Composer and NewsCutter, and Quantel’s QEffects. Though the Graphics 

Plugin versions are tailored to the specific platforms, the overall setup and user interface is the same.

Viz Trio, Viz Pilot, and the  are all graphical user interfaces that allow the NLE Graphics Plugin Editor

user to interact with the Vizrt graphics workflow and edit graphics elements. The Graphics Plugin 

supports NLE systems on both Windows and Apple platforms. Viz Trio and Viz Pilot are both available 

for , whereas the Graphics Plugin Editor is also available for the Windows-based NLE Systems Mac-based 

.NLE Systems

This section contains information on the following topics:

Supported Operating Systems

New Features in this Version

Current Software Limitations

Basic Workflow

Typical Workflows for NLE Work Stations

2.1 Supported Operating Systems

The Graphics Plugin supports two operating systems; Microsoft Windows and Apple Macs using OS X 

10.6 Snow Leopard, or later. The basic setup is in principle the same; however, there are some differences 

in how they are used, and what software is used in addition to the plugin.

Both setups need a Viz Engine for graphics rendering, and a database that stores the data for each graphics 

template or data element. The “database” can either be a Media Sequencer or a Viz Pilot database. The 

Viz Pilot database can only be used by Windows-based Graphics Plugins in conjunction with Viz Pilot.

The main components used with the Graphics Plugin are:

Viz Engine is a real-time graphics renderer, and at the core of the Vizrt graphics workflow.

Connection Broker performs connection broking, providing all Graphics Plugin system users with a 

single connection point for graphics rendering.

Note:

Based on the Graphics Plugin SDK Guidelines, a tailored version of the Graphics Plugin has also been 

developed in order to suit the workflow of Easycut (Vizrt’s timeline based proxy video editing tool). 

For more information on this specific Graphics Plugin version, see the .Easycut Manual

......................................................................................................................................................................

......................................................................................................................................................................
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Media Sequencer is a framework for defining and executing media elements on a Viz Engine. The 

media elements are defined in a tree-based schedule that the Media Sequencer interprets, but for the 

Graphics Plugin, it is simply used as a storage solution for Viz Trio, which is used by the Graphics 

Plugin Editor.

Viz Pilot database is an Oracle 10g or 11g database that stores template data and references to the 

template graphics. The Viz Pilot database is mainly used in conjunction with Viz Pilot.

2.1.1 Windows-based Systems

For Windows users there are two editors available for adding graphics to a video clip; Viz Trio and Viz 

Pilot. Viz Trio is bundled with the Graphics Plugin installer, whereas Viz Pilot must be installed 

separately, as it connects to the Viz Pilot database for the template data and graphics.

2.1.2 Mac-based Systems

For Mac users, the plugin has its own built-in . The editor is capable of reading Viz Graphics Plugin Editor

Trio shows stored on the Media Sequencer and remote previewing the Viz Engine graphics as well as 

editing the text and image properties of graphic scenes.

The Mac-based Graphics Plugins are unable to control or use Viz Trio and Viz Pilot remotely as a user 

interface, hence the Graphics Plugin Editor.

See Also

Supported NLE Systems

Mac-based NLE Systems (for details on installation and configuration)

2.2 New Features in this Version

The following new features have been added to the various Graphics Plugins in version 2.1:

2.2.1 Graphics Plugin for Quantel

Support for Pilot Edge

The plugin is now a MLT FX plugin instead of the older QEffects plugin type.

Images from Viz One are now supported when using Pilot or Pilot Edge

2.3 Current Software Limitations

There are limitations to what a Graphics Plugin solution can do compared to a full SDI in-and-out Viz 

Engine renderer.

These are the general Graphics Plugin limitations on :both Windows and Mac

Media Sequencer 1.19 and later, Viz Engine 3, and Connection Broker 3.0 and later, do not 

announce their presence on the computer network. The Graphics Plugin configuration tool will 

therefore not automatically discover these services.

These are the specific Graphics Plugin limitations on :Windows only
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1.  
2.  

3.  

4.  

5.  

For Avid installations, not all Graphics Plugin versions prior to 1.5 are automatically removed when 

upgrading.

These are the specific Graphics Plugin limitations on :Mac only

It is only possible to input text, change numeric values, and select images/geometries/fonts/materials. 

There is no support for input of boolean values. There is no support for editing ControlList/Tables or 

Scrolls. However, the editor can pick up Viz Trio pages created using a regular Viz Trio, and render 

them, even though they may have these field types.

The Graphics Plugin Editor cannot create shows and import scenes, so you must use Viz Trio 2.6 or 

later to create shows and import scenes for the Graphics Plugin Editor to use.

It is not possible to select images from a local path in the Graphics Plugin Editor.

2.4 Basic Workflow

The basic Graphics Plugin workflow is straight forward:

Import video -> Import graphic -> Move graphic to video

2.4.1 The typical workflow from template design to rendering

A typical workflow consists of the following steps:

A graphics designer creates a scene in Viz Artist.

The scene is either added as a template to a Viz Trio show or created as a template for use with 

Viz Pilot in Template Wizard.

An editor or a journalist edits a video using an NLE system.

Using Vizrt’s Graphics Plugin, the user can access and add graphics to the video.

Graphics properties can be edited using the graphics templates in either the Graphics Plugin 

Editor, Viz Trio, Viz Pilot or Viz Pilot Edge.

The video clip is rendered and saved to a shared file server or a Media Asset Management (MAM) 

system, such as Viz One.
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5.  

1.  
2.  

3.  

4.  
5.  

6.  
7.  

8.  

9.  

Once the file is saved or posted to the MAM system, it can also be added to a playlist for playout 

on Viz Engine.

For details on how to use the Graphics Plugin in the various , see Supported NLE Systems VizBoldTypical 

.Workflows for NLE Work Stations

2.5 Typical Workflows for NLE Work Stations

The third party NLE workstations have different ways of importing and inserting graphics into video, but 

the Graphics Plugin itself has the same interface across all third-party programs.

The various workflows are described in the following sections:

Graphics Plugin Workflow with Adobe Premiere Pro

Graphics Plugin Workflow with Avid Media Composer

Graphics Plugin Workflow with Apple Final Cut Pro

Graphics Plugin Workflow with Apple Final Cut Pro X

Graphics Plugin Workflow with Quantel

2.5.1 Graphics Plugin Workflow with Adobe Premiere Pro

The following steps are performed when adding Vizrt graphics to a sequence in Adobe Premiere Pro:

Open a project in Adobe Premiere Pro.

Add a  clip to the project:Transparent Video

In the Project panel, make sure that the Project tab is selected, and click the  button New Item
in the lower right corner.

From the menu that appears, click .Transparent Video

In the New Transparent Video dialog box that opens, click .OK
Drag the new transparent video clip to the Sequence panel.

Add the Graphics Plugin to the project:

In the Project panel, click the  tab.Effects

Navigate to , and drag the plugin onto the Video Effects > Vizrt > Graphics Plugin
transparent video clip in the Sequence panel.

Select the transparent video clip that holds the plugin.

Click the  tab in the upper left corner.Effect Controls
(If the Effect Controls tab is not visible, go to the menu bar > Window > Effects Control, and 

check this option).

Navigate to , and click the  button that appears.Graphics Plugin > Control Edit
In the editor (Viz Trio, Viz Pilot or Graphic Plugin Editor), specify the controllable items of the 

graphics element being used, and click the  button.Save/Save and Render in NLE
Back in Adobe Premiere Pro, a graphics element has now been added to the transparent video clip.

Note:

It is a prerequisite that the Graphics Plugin for Adobe has been successfully configured, see 

.Configuring Adobe Premiere Pro on Mac

......................................................................................................................................................................

......................................................................................................................................................................
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9.  

1.  
2.  
3.  

4.  

5.  
6.  

Create another Transparent Video with graphics plugin and drag it to the timeline to have multiple 

graphics.

2.5.2 Graphics Plugin Workflow with Avid Media Composer

For Windows, the supported editors are Viz Trio and Viz Pilot.

For Mac, the supported editors are Graphics Plugin Editor (acts like Viz Trio to retrieve the scene from the 

Media Sequencer) and Viz Pilot (where Viz Pilot is on a remote host).

In Avid Media Composer, create a new project.

Import a video by right-clicking on the  window and selecting .Bin Import

Click on the film icon on the item that you imported, and drag into the  window.Timeline

In the Project window, click on the  tab (represented by a square purple icon), select Effect Palette
, and drag it to the video in the Timeline window.Vizrt > Graphics Plugin

Open the  by going to .Effect Editor Tools > Effect Editor

In the Effect Editor window, under the Graphics Plugin, select the  checkbox to start Editor
importing graphics into Media Composer. Viz Trio, Viz Pilot or the Graphics Plugin Editor (Mac) 

will be started.
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6.  

7.  
8.  

9.  

1.  
2.  
3.  
4.  
5.  

6.  
7.  
8.  
9.  

10.  

Edit and save a template.

Check that you are in  mode (the Mixer icon is highlighted in the Timeline window). This Effect
allows you to see graphics animations in the Preview windows.

Play the video clip or scrub the timeline to see the new effect.

2.5.3 Graphics Plugin Workflow with Apple Final Cut Pro

Start Final Cut Pro.

Import and add a video clip to the timeline.

Drag the  generator effect to the timeline.Graphics Plugin

Double-click the effect on the timeline to enable the effect controls in the  window.Viewer

Click the  button under the  tab, and the Graphics Plugin Editor Graphics Plugin Editor Controls
will be started.

Edit and save a template.

When done, click .OK
Scrub the timeline to see the new effect.

Press  to render the new effects.Command + R
Play the video clip to see the new effect.

Note:

The graphics will not preview if you created another video layer with the plugin.

......................................................................................................................................................................

......................................................................................................................................................................
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6.  

7.  
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9.  

1.  
2.  

3.  

4.  

2.5.4 Graphics Plugin Workflow with Apple Final Cut Pro X

To use Vizrt graphics in Final Cut Pro X (FCPX), you need to generate a graphics template in Motion 

first. The only thing that FCPX can do is to adjust the length and position of the graphics to align with the 

video, so the majority of the tasks (such as importing graphics or doing NLE configuration) are done 

within Motion.

With Final Cut Pro X, use Motion to create a Final Cut Generator, then use this generator in FCPX to add 

the effect on your timeline. You can have a single Viz generator that you will edit in FCPX, or one 

preconfigured generator per scene.

Start  and select Final Cut Generator.Motion
On the right-hand side, click Add a generator > Generator > Vizrt Graphics.

Go to the Inspector tab, select the Generator tab and choose Editor.

Here you will find the Config and Editor buttons. With the editor, you can open Viz Trio or the 

Graphic Plugin Editor, and select and configure the scene to use in the effect.

Import a graphic and save.

If you want to be able to edit the scene or the configuration from Final Cut Pro X, you need to 

explicitly allow it from Motion. To do this:

Hover over the Setting area under the Generator tab

Click the arrow icon that appears near the Config button

Choose Publish

Save the template. You can create a new category for Vizrt Graphics so that items are easier to 

find later.

You are now ready to use the Generator in FCPX.

Open , create a new project and import media.FCPX
Your effect will now appear in the generator list. Drag your effect to the timeline.

If you have explicitly published the parameters in Motion, you will see the Config and Editor 

buttons when selecting your effect and go into the Generator configuration panel.

Click on the Generator button, select the graphics template from step 6 and drag it into the 

timeline

To export the video without burning in the Viz graphics

Select your effect and go in its Info configuration panel

Select the Roles parameter and then select Edit Roles in the popup menu. The Role Editor window 

will appear.

In the lower-left corner of the Role Editor, click the "+" button to add a new video role named 

"VizGfx".

Make sure you select this role for all your Viz effects.

Note:

Once you have saved your effect in Motion, you must restart FCPX to make sure that it 

recognizes your new generator.

......................................................................................................................................................................

......................................................................................................................................................................
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5.  

1.  

2.  

3.  

4.  

When exporting your video with (File > Share > Master File), go to the Settings panel and set the 

Roles As parameter to .Multitrack QuickTime Movie

You will get a button to edit the roles you want to export. Click on it and unselect "VizGfx" to get 

all the effects except yours.

2.5.5 Graphics Plugin Workflow with Quantel

In Quantel, import a video by dragging a clip from the file browser to the workspace, and then 

clicking the  buttonImport

Make the video available as a layer by dragging the video to the preview pane. It is now available 

as a layer and can be seen on the timeline.

Create a layer for the Graphics Plugin effect by pressing the  button (to the left of the Layer
timeline), and then dragging it on top of the video layer on the timeline.
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4.  

5.  

6.  

7.  
8.  

Add the Graphics Plugin effect to the layer by selecting the  button in Quantel Tracker > Qplugin
and then selecting Favorites > Vizrt > select > VizNlePlugin

To change the starting point or duration of the effect, drag the mouse over the Start and Duration 

fields in the Vizrt Editor box.

Edit the effect by pressing the  button. The editor will open.Vizrt Editor
For example, in Viz Trio, you can save a template as a page, make changes to the page and then 

preview it. Press .Save and Render in NLE
In Quantel, scrub to see the effect.

Render the sequence by pressing the  button.Render

Tip:

For a demonstration of Quantel and the Graphics Plugin, see the following tutorial video.

......................................................................................................................................................................

......................................................................................................................................................................

http://www.vizrt.com/training/tutorials/34962/Graphics_Plugin_1.8_integration_with_Quantel
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3 Requirements and Recommendations

This section covers hardware, software and network requirements and recommendations, information 

about supported NLE systems, and necessary references to other Vizrt system guides for complementary 

information.

This section contains information on the following topics:

Software Requirements

Supported NLE Systems

Network Requirements

3.1 Software Requirements

This section gives an overview of the Vizrt software and NLE systems supported by the Graphics Plugin.

For full details, see the Graphics Plugin Release Notes.

This section contains information on the following topics:

Client Software Requirements

Server Software Requirements

3.1.1 Client Software Requirements

The Graphics Plugin has been tested with the following software:

Graphics Plugin for Adobe 2.1.0

Graphics Plugin for Adobe on Windows:

Microsoft Windows 7, 64-bit

Adobe Premiere Pro CC 2014

Viz Pilot 6.0.0

Graphics Plugin for Adobe on Mac:

Apple OSX 10.10.3 on Intel Hardware.

Adobe Premier Pro CC 2014

Graphics Plugin for Final Cut 2.0.0

Final Cut Pro 7

Apple OSX 10.10.3 on Intel Hardware.

Graphics Plugin for Avid 2.0.0

Graphics Plugin for Avid on Windows

Microsoft Window 7, 64-bit

Avid Media Composer 8.1

Viz Pilot 6.0.0
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Graphics Plugin for Avid on Mac

Avid Media Composer 8.1

Apple OSX 10.10.3 on Intel Hardware

3.1.2 Server Software Requirements

The server components used by Graphics Plugin have different system requirements. A summary is 

provided here, but refer to the individual release notes and manuals for details. Please note that it is not 

recommended to install all components on a single server.

Connection Broker 4.0

Optional, it is still possible to specify a specific Viz Engine directly.

Requires Microsoft .NET 4.5.

It can be installed on the same server as a Media Sequencer or a Viz Engine, or on a separate 

computer.

Connection Broker 1.0.0 can be used, but some of the new features in Viz Engine 3.5 will not 

work. This may impact performance.

Connection Broker 1.1 can be used but some of the new features in Viz Engine 3.7 will not 

work.

Media Sequencer 2.0.3 and 3.0.0

Requires Microsoft .NET 4.0.

Connecting multiple Graphics Plugin workstations to the same Media Sequencer makes it 

easier to share graphics elements between Graphics Plugin clients.

Elements saved to an MSE from Viz Trio on Windows can be used from the Graphics Plugin 

Editor for Mac OS X, and vice versa.

Installing it on a Viz Engine server is not recommended since high memory usage can interfere 

with Viz Engine performance.

Viz Pilot 6.0.0,  6.0.0Pilot Data Server
Used by Graphics Plugin Editor (the Mac OS X editor) as a source for images to be used in 

graphics.

The components are optional. If they are not used, Graphics Plugin Editor can still use images 

from the Viz Engine.

Viz Engine 3 /  3Viz Artist
Viz Engine 3.7.0 and 3.8.0.

If you need to use older versions the recommended versions are 3.2.8, 3.3.1 and 3.5.1

Viz Engine 3.7 or newer is required to take advantage of the new aspect independent frame 

fetching.

Viz Engine 3.5 or newer is required to take advantage of the new custom resolution frame 

fetching and anti-aliasing.

Viz Engine 3.5.0, 3.3.0, and 3.2.7 or earlier, have some known issues that can cause (rare) 

rendering artifacts when multiple NLE clients are using the same engine. We recommend Viz 

Engine 3.2.8, 3.3.1 and 3.5.1 or newer.

It is highly recommended to have a fast (Gigabit) network connection between each NLE 

workstation and Viz Engine.

This version of Graphics Plugin only supports UTF-8 encoding for the Viz Engine.
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3.2 Supported NLE Systems

The list below is the current list of supported NLE systems that is within the scope of this document. 

Other versions are not officially supported unless it is specifically mentioned as part of this document.

The following systems are supported:

Adobe Premiere Pro

Apple Final Cut Pro

Avid Media Composer and Avid NewsCutter

Quantel Rio

Adobe Premiere Pro Creative Cloud (CC)

3.2.1 Adobe Premiere Pro

The  works together with Adobe Premiere Pro from version CS5 (including Graphics Plugin for Adobe
versions CS5.5 and CS6). This plugin works on both Windows-machines and Macs.

The Graphics Plugin for Adobe also works together with Adobe Premiere Pro Creative Cloud (CC). This 

setup has been tested to work on Windows-machines.

3.2.2 Apple Final Cut Pro

The  works together with Apple Final Cut Pro 6 and 7 (available in Final Graphics Plugin for Final Cut
Cut Studio 2 and 3, respectively), and Final Cut Pro X. This plugin works on Mac-machines only.

3.2.3 Avid Media Composer and Avid NewsCutter

The  works together with Avid Media Composer and NewsCutter. This plugin Graphics Plugin for Avid
works on both Windows-machines and Macs.

The plugin for Avid has been tested with Avid’s Media Composer and NewsCutter; however, all systems 

supporting the Avid Extensions (AVX) 2.0 System Development Kit (SDK) should work. The following 

Avid products have AVX2 support:

Avid Digital Studio (DS)

Media Composer (Older Release and Post Adrenaline HD release that can run software only), Media 

Composer Adrenaline, and Media Composer Adrenaline HD

Note:

In addition to Adobe Premiere Pro, the Graphics Plugin for Adobe pluginsupportAdobe AfterEffects 

from version CS5.

......................................................................................................................................................................

......................................................................................................................................................................

Note:

There are separate installers for versions 6+7, and X.

......................................................................................................................................................................

......................................................................................................................................................................
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NewsCutter, NewsCutter FX, NewsCutter XP, and NewsCutter Adrenaline (FX)

Symphony and Symphony Nitris

Xpress, Xpress Pro, and Xpress Pro HD

Separate Graphics Plugin for Avid installers apply for Windows 32- and 64-bit systems. The 32-bit 

Graphics Plugin version works together with Media Composer 5 and NewsCutter 9, whereas the 64-bit 

version works with the new Media Composer 6 and NewsCutter 10.

3.2.4 Quantel Rio

The  works together with Quantel Rio 4.3, or later. This plugin works on Graphics Plugin for Quantel
Windows-machines only.

3.2.5 Adobe Premiere Pro Creative Cloud (CC)

The  works together with Adobe Premiere Pro Creative Cloud (CC). The Graphics Plugin for Adobe
system is supported by Windows 8.1.

3.3 Network Requirements

A Viz Engine can be shared by multiple simultaneous NLE clients; however, there are no recommended 

number of users for SD and HD as this in most cases is a performance issue and not a fixed limitation.

The Windows- and Mac-based NLE system setup typically operate on a single Viz Engine. This requires 

transportation of frames (images) over the network, so a fast network connection is recommended, 

preferably a gigabit switched network connection; however, a megabit (100 Mbit/s) connection will also 

work as the plugin supports lossless data compression using Portable Network Graphics (PNG) or Run-

length Encoding (RLE) instead of uncompressed raw images.

3.3.1 Port Numbers

The table below describes all listeners, port numbers, and which applications that use the port numbers to 

establish a connection.

Note:

Avid Liquid, previously known as Pinnacle Liquid, has been discontinued byAvid, and is currently 

not supported by the Graphics Plugin.

......................................................................................................................................................................

......................................................................................................................................................................

Note:

Version 2.0 of the Graphics Plugin supports earlier versions of Quantel QEffects/Rio (version 4.2).

......................................................................................................................................................................

......................................................................................................................................................................

Note:

RLE is only supported by Viz Engine 3.2.2, or later.

......................................................................................................................................................................

......................................................................................................................................................................
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3.3.2 Port numbers

Listener Port Description

Viz Engine 6100 Default port used for graphics 

rendering.

Viz Trio 6210 Used by the Graphics Plugin to 

establish a connection to Viz Trio.

Viz Pilot 6220 Used by the Graphics Plugin to 

establish a connection to Viz Pilot.

Graphics Plugin Editor 6230 Used by the Graphics Plugin to 

establish a connection to the 

Graphics Plugin Editor.

Viz Pilot Edge 6230 Used by the Graphics Plugin to 

establish a connection to Viz Pilot 

Edge.

Graphics Plugin Config 6240 Used by the Graphics Plugin to 

establish a connection to the 

Graphics Plugin configuration tool.

Media Sequencer 8594 Port used by all clients that connect 

to the Media Sequencer.

Viz Engine 14300 Alternative port used to avoid 

conflicts with port 6100. Port 6100 

is normally used by renderers that 

are on air, hence, it is (for example 

when running Viz Pilot version 4) 

recommended to use another port.

Viz Engine (multiplexed) 50007

50008

50009

Used by clients that connect to a 

multiplexed Viz Engine.

50007: Isolated port. All 

connections to this port get its own 

session. The port is used by the 

Graphics Plugin to deliver frames to 

the host NLE system. For example 

rendering or scrubbing of video 

clips with graphics. Using this port 

will also suppress bounding box 

commands. Cannot be used by Viz 

Pilot.

50008: Shared port. All connections 

from one single host share one 

session. Used by Viz Trio and Viz 

Pilot to display preview frames.
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Listener Port Description

50009: Fixed port. Same as shared 

port, except that allocated resources 

are never cleared from memory. 

Used by Viz Pilot 4.

Connection Broker 21098 Connection to the Connection 

Broker configuration interface (for 

example ).http://localhost:21098/

http://localhost:21098/
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4 Installation and Configuration

The following sections describe the different setup procedures. The sections follow the order of a new 

installation.

System Components

Graphics Rendering

Connection Broker

Mac-based NLE Systems

Windows-based NLE Systems

4.1 System Components

All installations use a Viz Engine in combination with a database. The “database” is either a Media 

Sequencer, used by Viz Trio or Graphics Plugin Editor, or Viz Pilot’s database used by Viz Pilot.

The following illustration gives an overview of an NLE system using the .Connection Broker

The Viz Engine must handle multiple simultaneous requests. In Viz Engine, the multiplexing functionality 

is a built-in feature.

Note:
......................................................................................................................................................................
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The Graphics Plugin supports different NLE systems on both Windows and Mac, and the setup is 

basically the same for both platforms. The Graphics Plugin configuration tool is used to configure the 

plugin, Viz Engine, the Media Sequencer and the editor(s).

The Graphics Plugin Editor for Mac supports browsing and previewing of Viz Trio templates and pages 

stored on a Media Sequencer.

Viz Trio and Viz Pilot both support browsing and previewing of Viz Trio templates and pages stored on a 

Media Sequencer and templates and data elements stored on the Viz Pilot database, respectively.

Note that effects are bound to the editor that made them, even if you subsequently switch to a different 

editor. This binding happens the first time "Editor" is clicked for a specific effect, not the instant the effect 

is dragged down onto the timeline.

4.2 Graphics Rendering

In order for an NLE system to render graphics, a successful connection to a Viz Engine must be 

established.

For the Viz Engine, off-screen rendering is the default rendering mode.

4.2.1 To setup a Viz Engine for graphics rendering

Start the installer and select  mode.VGA

4.3 Connection Broker

The Viz Pilot workflow is only available to Windows-based NLE systems.
......................................................................................................................................................................

Note:

NLE system-specific installations are outside the scope of this guide.

......................................................................................................................................................................

......................................................................................................................................................................
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2.  
3.  

The Connection Broker is a component that manages a pool of Viz Engines. Clients can query it for a Viz 

Engine that matches a specific video mode. It provides load balancing, video mode matching and can be 

used to create a redundant renderer pool.

This section describes the following Connection Broker-related procedures:

To install the Connection Broker

To add a Viz Engine to the Connection Broker

To remove a Viz Engine from the Connection Broker

To modify the ping interval from the Connection Broker towards a Viz Engine

4.3.1 To install the Connection Broker

Run the Conection Broker installer file (*.exe) to start the .Connection Broker Setup

Make sure that the  is correctly defined.Install Location

Click .INSTALL

Note:

The Preview Server is bundled together with the Connection Broker. Both components have their own 

service document URL, but they share the same pool of Viz Engines. Note that if both services are 

used extensively, the load on the joint pool may be higher than what is recommended.

......................................................................................................................................................................

......................................................................................................................................................................

Note:

The installation requires Microsoft .NET 4.5.

......................................................................................................................................................................

......................................................................................................................................................................
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3.  

4.  When the installation is complete, click .FINISH
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4.  

5.  From the  menu, navigate to Start All Programs > Vizrt > Connection Broker > Connection 

.Broker Config

The Connection Broker’s web interface will open if the service is running (address http://localhost:21098/

).

Tip:
......................................................................................................................................................................

http://localhost:21098/
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1.  

2.  

1.  

2.  

3.  

4.3.2 To add a Viz Engine to the Connection Broker

In the Connection Broker web interface, enter the Viz Engine hostname or IP address in the text 

box.

Click .Add New

4.3.3 To remove a Viz Engine from the Connection Broker

In the Connection Broker web interface, click the  icon next to the Viz Engine entity that is trash can

to be removed.

4.3.4 To modify the ping interval from the Connection Broker towards a Viz Engine

Locate the  file, typically located at Connection Broker.exe.config C:\Program Files (x86)

.\Vizrt\Connection Broker

In the configuration file, set a new value for the  option, which VizEnginePollIntervalMilliSeconds

controls the interval for how often the Connection Broker will poll each Viz Engine.

Set a new value for the  option, which controls the timeout in VizEngineTimeoutMilliSeconds

milliseconds when trying to connect to a Viz Engine.

Code example:

It is possible to open the Connection Broker configuration from other machines. In order to do so, 

replace “localhost” with the actual hostname.
......................................................................................................................................................................

Note:

If not specified, the Viz Engine will be added with default port 50010. When using Viz Engines in a 

so-called dual channel setup, it is possible to run multiple instances of Viz Engine on a single host. 

Each instance uses a unique port, which means that two Viz Engines should only be considered 

duplicates when both the hostnames and port numbers are identical. When referring to Viz Engines in 

a dual channel setup, type the port number after the hostname (for example “VizEngine1:51007”).

......................................................................................................................................................................

......................................................................................................................................................................

<?xml version="1.0" encoding="utf-8"?>
<configuration>



31

    <configSections>
        <sectionGroup name="applicationSettings" type="System.
Configuration.ApplicationSettingsGroup, System, Version=4.0.0.0, 
Culture=neutral, PublicKeyToken=b77a5c561934e089">
            <section name="Vizrt.Frames.Properties.Settings" type="Sy
stem.Configuration.ClientSettingsSection, System, Version=4.0.0.0, 
Culture=neutral, PublicKeyToken=b77a5c561934e089" requirePermission="
false" />
        </sectionGroup>
    </configSections>
    <applicationSettings>
        <Vizrt.Frames.Properties.Settings>
            <setting name="VizEnginePollIntervalMilliSeconds" seriali
zeAs="String">
                <value>10000</value>
            </setting>
            <setting name="VizEngineTimeoutMilliSeconds" serializeAs=
"String">
                <value>10000</value>
            </setting>
            <setting name="CacheMaxAge" serializeAs="String">
                <value>86400</value>
            </setting>
            <setting name="VizEngineCleanupIntervalMilliSeconds" seri
alizeAs="String">
                <value>60000</value>
            </setting>
            <setting name="UseRunLengthEncoding" serializeAs="String"
>
                <value>False</value>
            </setting>
        </Vizrt.Frames.Properties.Settings>
    </applicationSettings>
    <system.serviceModel>
        <services>
            <service behaviorConfiguration="Vizrt.Frames.
AtomBrokerService" name="Vizrt.Frames.AtomBrokerService"></service>
        </services>
        <behaviors>
            <serviceBehaviors>
                <behavior name="Vizrt.Frames.AtomBrokerService">
                    <serviceDebug includeExceptionDetailInFaults="tru
e" httpHelpPageEnabled="false" httpsHelpPageEnabled="false" />
                </behavior>
            </serviceBehaviors>
        </behaviors>
    </system.serviceModel>
    <uri>
        <schemeSettings>
            <add name="http" genericUriParserOptions="DontUnescapePat
hDotsAndSlashes" />
            <add name="https" genericUriParserOptions="DontUnescapePa
thDotsAndSlashes" />
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4.4 Mac-based NLE Systems

Using a Mac-based NLE system, such as Apple’s Final Cut Studio or Adobe’s Premiere for Mac, requires 

an installation of the Graphics Plugin. The Graphics Plugin installs the Graphics Plugin configuration tool 

and the Graphics Plugin Editor.

This section contains information on the following topics:

Prerequisites for Mac-based NLE Systems

Introduction to Mac-based Graphics Plugin Systems

Installation of Mac-based Graphics Plugin Systems

Allow Mac NLE to use Editors on a Windows Remote Host

Configuring Adobe Premiere Pro on Mac

Configuring Avid Media Composer on Mac

Configuring Final Cut Pro on Mac

Configuring Final Cut Pro X on Mac

Removal of Mac-based Graphics Plugin Systems

        </schemeSettings>
    </uri>
    <startup>
        <supportedRuntime version="v4.0" sku=".NETFramework,
Version=v4.5.2" />
    </startup>
    <runtime>
        <assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1">
            <dependentAssembly>
                <assemblyIdentity name="System.Web.Http" publicKeyTok
en="31bf3856ad364e35" culture="neutral" />
                <bindingRedirect oldVersion="0.0.0.0-5.2.2.0" newVers
ion="5.2.2.0" />
            </dependentAssembly>
            <dependentAssembly>
                <assemblyIdentity name="Microsoft.Owin" publicKeyToke
n="31bf3856ad364e35" culture="neutral" />
                <bindingRedirect oldVersion="0.0.0.0-3.0.0.0" newVers
ion="3.0.0.0" />
            </dependentAssembly>
            <dependentAssembly>
                <assemblyIdentity name="System.Net.Http.Formatting" p
ublicKeyToken="31bf3856ad364e35" culture="neutral" />
                <bindingRedirect oldVersion="0.0.0.0-5.2.2.0" newVers
ion="5.2.2.0" />
            </dependentAssembly>
        </assemblyBinding>
    </runtime>
</configuration>
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4.4.1 Prerequisites for Mac-based NLE Systems

Before installing the Graphics Plugin, a Media Sequencer and a Viz Engine must be running (on a 

Windows machine).

The Media Sequencer should preferably contain a Viz Trio show to confirm that the connection is 

working properly; however, the Graphics Plugin Editor has status indicators indicating connections to Viz 

Engine, the host application (FCP or Premiere for Mac) and the Media Sequencer which should be 

sufficient information to confirm a correct setup.

4.4.2 Introduction to Mac-based Graphics Plugin Systems

The Graphics Plugin Editor is a tool used to fetch graphics content for use with NLE systems on Mac. 

This editor enables Mac-users to incorporate graphics from Vizrt’s Windows-based Viz Engine and Media 

Sequencer to the NLE workflow.

A  requires a Viz Engine and a Media Sequencer, where the Media Sequencer holds the actual basic setup

data (for example text and image reference(s)) and Viz Engine the graphic scenes.

A prerequisite is that a Viz Trio operator has created a show with graphics templates on the Media 

Sequencer. Once the show is available on the Media Sequencer, the Graphics Plugin Editor is able to 

display the graphics such that the NLE user can select and edit the content and add it to the timeline.
A more advanced setup that uses the  enables the Connection Broker to select engines Connection Broker

from a pool of Viz Engines.

Note:

Viz Engine and the Media Sequencer must both run on Windows 7, or later. It is recommended to run 

the Media Sequencer separately on a Windows Server 2008 or Windows 7. In smaller production 

environments, however, the Media Sequencer may run on the Viz Engine machine.

......................................................................................................................................................................

......................................................................................................................................................................
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A typical setup using the Graphics Plugin Editor is as follows:

NLE machines

Mac-based NLE system (Adobe, Avid, or Final Cut)

Graphics Plugin (with Graphics Plugin Editor)

Viz Engine

Graphic Hub with graphic scenes

Optional: Datapool plugins for Viz Engine

Optional: Connection Broker

4.4.3 Installation of Mac-based Graphics Plugin Systems

The following procedures install the Graphics Plugins, which enable the use of the Graphics Plugin 

configuration tool and the Graphics Plugin Editor.

To install the Graphics Plugin for Adobe on Mac

To install the Graphics Plugin for Avid on Mac

To install the Graphics Plugin for Final Cut Pro

To install the Graphics Plugin for Final Cut Pro X

To install the Graphics Plugin for Adobe on Mac

Double-click the  file (*.dmg) to open the package file.disk image

Double-click the  file (*.pkg) to start the installation.package

Note:

The installer requires an OS X user with administrator privileges.

......................................................................................................................................................................

......................................................................................................................................................................
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In the_ Graphics Plugin for Adobe installer, _click  until the installation has finished.Continue

Eject the file.

To install the Graphics Plugin for Avid on Mac

Double-click the  file (*.dmg) to open the package file.disk image

Double-click the  file (*.pkg) to start the installation.package

In the , click  until the installation has finished.Graphics Plugin for Avid installer Continue

Eject the file.

To install the Graphics Plugin for Final Cut Pro

Double-click the  file (*.dmg) to open the package file.disk image

Double-click the  file (*.pkg) to start the installation.package

In the , click  until the installation has finished.Graphics Plugin for Final Cut installer Continue

Eject the file.

To install the Graphics Plugin for Final Cut Pro X

Double-click the  file (*.dmg) to open the package file.disk image

Double-click the  file (*.pkg) to start the installation.package

In the  click  until the installation has finished.Graphics Plugin for Final Cut X installer, Continue

Eject the file.

The Graphics Plugin may not be shown in Final Cut Pro x if previous versions of the plugin are still 

installed. If this occurs, run the following commands in a terminal window:

Note:

Support for Avid on Mac is  in version 2.0 of the Graphics Plugin.new

......................................................................................................................................................................

......................................................................................................................................................................

Note:

Separate Graphics Plugin installers exist for Final Cut Pro 6+7 and Final Cut Pro X.

......................................................................................................................................................................

......................................................................................................................................................................

Note:

Separate Graphics Plugin installers exist for Final Cut Pro 6+7 and Final Cut Pro X. Previous versions 

of the plugin cannot be used with Final Cut Pro X.

......................................................................................................................................................................

......................................................................................................................................................................

sudo rm -rf /Library/Plug-Ins/FxPlug/viznle_plugin.fxplug 
sudo rm -rf /Library/Application Support/Final Cut Pro System Support
/Plugins/VizFcpNotifier.bundle
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4.4.4 Allow Mac NLE to use Editors on a Windows Remote Host

To allow a Mac-based NLE program to use other editors, such as Viz Pilot NLE, on a Windows remote 

host, do the following:

Start C:\Program Files(x86)\vizrt\Pilot 6.1\VCPAxNle.exe

In Premiere/Avid on the Mac, create a new effect and click Edit

NLE will now start communicating with Viz Pilot on the Windows host

Open a data element, and click save

The effect may now be rendered in Premiere/Avid

If you have used Graphic Plugin Editor on your Mac before, you must delete the existing plugin. You may 

also need to exit and re-open Avid Media Composer in order for the setting to be applied.

4.4.5 Configuring Adobe Premiere Pro on Mac

After the plugin has been configured the first time, the configuration can be accessed in various ways:

By clicking the  buttonGraphics Plugin Config
By selecting the  option on the  menu. Optional: Graphics Plugin Config Graphics Plugin Editor

Press the shortcut keys Command + , (comma).

For details on advanced configuration options, see the Graphics Plugin configuration tool’s tooltips or the 

 section.Graphics Plugin Configuration Tool

To configure the Graphics Plugin for Adobe on Mac using the configuration tool

Start Adobe Premiere Pro for Mac.

Open a project.

Add a  clip to the project:Transparent Video

In the Project panel, make sure that the Project tab is selected, and click the  button New Item
in the lower right corner.

From the menu that appears, click .Transparent Video
In the New Transparent Video dialog box that opens, make sure the resolution matches the 

current sequence settings, and then click .OK
Drag the new transparent video clip to the Sequence panel.

Add the Graphics Plugin to the project:

In the Project panel, click the  tab.Effects

Navigate to , and drag the plugin onto the Video Effects > Vizrt > Graphics Plugin
transparent video clip in the Sequence panel.

Select the transparent video clip that holds the plugin.

Note:

Transition Logic scenes need to use Viz Pilot as the editor. They will not work if using Viz Trio

/GraphicPlugin Editor.

......................................................................................................................................................................

......................................................................................................................................................................
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Click the  tab in the upper left corner.Effect Controls

Press the  icon.Setup

From the dialog box that appears, click .Configure
The  then opens.Graphics Plugin configuration tool

Make sure that the  tab is selected.General
Select a Viz Engine:

Specific Viz Engine: Sets a Viz Engine connection.

Connection Broker: Sets a  connection.Connection Broker

Select a .Media Sequencer

Click the  button to confirm the settings and close the configuration tool.OK

4.4.6 Configuring Avid Media Composer on Mac

See .Graphics Plugin Workflow with Avid Media Composer

4.4.7 Configuring Final Cut Pro on Mac

After the plugin has been configured the first time, the configuration can be accessed in various ways:

As a result of an error message, for example if the Viz Engine or Media Sequencer is unavailable

By clicking the  button (see Graphics Plugin Config To configure the Graphics Plugin for Final Cut 

)using the configuration tool

By selecting the  option on the  menu. Optional: Graphics Plugin Config Graphics Plugin Editor

Press the shortcut keys Command + , (comma).

For details on advanced configuration options, see the Graphics Plugin configuration tool’s tooltips or the 

 section.Graphics Plugin Configuration Tool

To configure the Graphics Plugin for Final Cut using the configuration tool

Start Final Cut Pro.

Select the  tab in the Browser window, and add the  effect to the timeline.Effects Graphics Plugin

Select the  tab and click the  button.Controls Graphics Plugin Config
In the  that opens, select a Viz Engine.Graphics Plugin configuration tool

Viz Engine: Sets a Viz Engine connection.

Connection Broker: Sets a  connection.Connection Broker

Note:

To apply a new configuration, close and reopen your NLE system. If the new settings are still not 

applied, delete the existing graphic and add a new one.

......................................................................................................................................................................

......................................................................................................................................................................

Note:

To apply a new configuration, close and reopen your NLE system. If the new settings are still not 

applied, delete the existing graphic and add a new one.

......................................................................................................................................................................

......................................................................................................................................................................
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Select a .Media Sequencer

Click the  button to confirm the settings and close the configuration tool.OK

4.4.8 Configuring Final Cut Pro X on Mac

See step 5 of .Graphics Plugin Workflow with Apple Final Cut Pro X

4.4.9 Removal of Mac-based Graphics Plugin Systems

The following procedures describe how to delete the Graphics Plugins.

To remove the Graphics Plugin for Adobe on Mac

To remove the Graphics Plugin for Avid on Mac

To remove the Graphics Plugin for Final Cut

To remove the Graphics Plugin for Final Cut Pro X

To remove the Graphics Plugin for Adobe on Mac

To remove the Graphics Plugin for Adobe, use Finder, Terminal or some other tool to remove the 

following files:

/Library/Plug-ins/MediaCore/viznle_plugin.plugin

/Library/Application Support/Adobe/Common/Plug-ins/[CS version]

/MediaCore/viznle_plugin. plugin per installed CS version (for example CS5 and CS6)

To remove the Graphics Plugin for Avid on Mac

To remove the Graphics Plugin for Avid, use Finder, Terminal or some other tool to remove the following 

files:

/Library/Application Support/Avid/AVX2_Plug-ins/Vizrt/AvidGraphicsPlugin.avx/

Note:

If all connections are working properly, a list of Viz Trio shows from the Media Sequencer should 

appear. Selecting a show will display all templates. Selecting a template will display the tab-fields and 

preview the graphics.

......................................................................................................................................................................

......................................................................................................................................................................

Note:

To apply a new configuration, close and reopen your NLE system. If the new settings are still not 

applied, delete the existing graphic and add a new one.

......................................................................................................................................................................

......................................................................................................................................................................

Note:

To apply a new configuration, close and reopen your NLE system. If the new settings are still not 

applied, delete the existing graphic and add a new one.

......................................................................................................................................................................

......................................................................................................................................................................
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To remove the Graphics Plugin for Final Cut

To remove the Graphics Plugin for Final Cut, use Finder, Terminal or some other tool to remove the 

following files:

/Library/Plug-ins/FxPlug/viznle_plugin.fxplug

/Library/Application Support/Final Cut Pro System Support/Plugins/VizFcpNotifier.bundle

/Library/Frameworks/VizCocoa.framework (used by older Graphics Plugin versions)

To remove the Graphics Plugin for Final Cut Pro X

To remove the Graphics Plugin for Final Cut X, use Finder, Terminal or some other tool to remove the 

following files:

/Applications/FCPXGraphicsPlugin.app

4.5 Windows-based NLE Systems

Using a Windows-based NLE system, such as Avid’s Media Composer, Adobe’s Premiere, or Quantel’s 

QEffects, requires an installation of the Graphics Plugin. The Graphics Plugin installs the Graphics Plugin 

configuration tool and an NLE version of Viz Trio.

In order to configure the Graphics Plugin for use, a Media Sequencer and a multiplexed Viz Engine must 

be running.

This section contains information on the following topics:

Introduction to Windows-based Graphics Plugin Systems

Installation of Windows-based Graphics Plugin Systems

Basic Configuration of Windows-based Graphics Plugin Systems

Advanced Configuration of Windows-based Graphics Plugin Systems

Removal of Windows-based Graphics Plugin Systems

4.5.1 Introduction to Windows-based Graphics Plugin Systems

Viz Trio is an advanced character generator that is used to produce content for use with a Windows-based 

NLE system. Similar to the Graphics Plugin Editor, Viz Trio basically requires a Viz Engine and a Media 

Sequencer.

Note:

Viz Engine and the Media Sequencer both run on Windows XP or 7. Note that Viz Engine 3.7, and 

later, do not support Windows XP. It is recommended to run the Media Sequencer separately on a 

Windows Server 2008 or Windows 7. In smaller production environments, however, the Media 

Sequencer may run on the Viz Engine machine.

......................................................................................................................................................................

......................................................................................................................................................................
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A typical setup using Viz Trio is as follows:

NLE machines

NLE system

Graphics Plugin (includes bundled Viz Trio)

Media Sequencer

Viz Engine

Graphic Hub with graphic scenes

Optional: Datapool plugins for Viz Engine

Viz Pilot basically requires a Viz Engine and a Viz Pilot database. The Viz Pilot database (Oracle 10g) is 

where the templates, template data elements, and its associated data is stored.

A typical setup using Viz Pilot is as follows:

NLE machines

NLE system

Viz Pilot

Graphics Plugin
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Viz Pilot database installation

Oracle 10g

Viz Engine

Graphic Hub with graphic scenes

Optional: Datapool plugins for Viz Engine

4.5.2 Installation of Windows-based Graphics Plugin Systems

The installer requires a Windows user with administrator privileges.

To install the Graphics Plugin for Adobe on a Windows machine

To install the Graphics Plugin for Avid on a Windows Machine

To install the Graphics Plugin for Quantel

To install the Graphics Plugin for Adobe on a Windows machine

Double-click the  file (*.msi) to start the installation.Windows installer

Click  in the appearing Welcome dialog box.Next

Click  in the  dialog box.Next Custom Setup
Optional: Select the features to be installed.

Optional: Select a different installation location.

Click  in the Ready to Install dialog box to start the installation.Install

Click  to end the installation process.Finish

See Also

To configure the Graphics Plugin for Adobe on a Windows machine using the configuration tool

To remove the Graphics Plugin for Adobe from a Windows machine

To install the Graphics Plugin for Avid on a Windows Machine

Double-click the  file (*.msi) to start the installation.Windows installer

Click  in the appearing Welcome dialog box.Next

Click  in the  dialog box.Next Custom Setup
Optional: Select the features to be installed.

Note:

Adobe Premiere Pro (or Adobe AfterEffects) must be installed on the workstation before installing the 

Graphics Plugin for Adobe.

......................................................................................................................................................................

......................................................................................................................................................................

Note:

Separate installers apply for 32- and 64-bit NLE systems. The 32-bit installer should be used together 

with Media Composer 5/NewsCutter 9 (or older), the 64-bit installer with Media Composer 6

/NewsCutter 10.

......................................................................................................................................................................

......................................................................................................................................................................
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Optional: Select a different installation location.

Click  in the Ready to Install dialog box to start the installation.Install

Click  to end the installation process.Finish

See Also

To configure the Graphics Plugin for Avid on a Windows machine using the configuration tool

To remove the Graphics Plugin for Avid from a Windows machine

To install the Graphics Plugin for Quantel

Double-click the  file (*.msi) to start the installation.Windows installer

Click  in the appearing Welcome dialog box.Next

Click  in the  dialog box.Next Custom Setup
Optional: Select the features to be installed.

Optional: Select a different installation location.

Click  in the Ready to Install dialog box to start the installation.Install

Click  to end the installation process.Finish

See Also

To configure the Graphics Plugin for Quantel using the configuration tool

To remove the Graphics Plugin for Quantel

4.5.3 Basic Configuration of Windows-based Graphics Plugin Systems

This section explains the basic configuration of a Graphics Plugin for Windows.

For Advanced configuration options, open the configuration tool and select the Advanced tab. For more 

information about the Advanced options, see the Graphics Plugin configuration tool’s tooltips or the 

 section.Graphics Plugin Configuration Tool

Configuration steps for the following plugins are described:

To configure the Graphics Plugin for Adobe on a Windows machine using the configuration tool

To configure the Graphics Plugin for Avid on a Windows machine using the configuration tool

To configure the Graphics Plugin for Quantel using the configuration tool

To configure the Graphics Plugin for Adobe on a Windows machine using the configuration tool

Start the NLE system; Adobe Premiere Pro.

Open a project.

Add a  clip to the project:Transparent Video

In the Project panel, make sure that the Project tab is selected, and click the  button New Item
in the lower right corner.

From the menu that appears, click .Transparent Video

In the New Transparent Video dialog box that opens, click .OK
Drag the new transparent video clip to the Sequence panel.
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Add the Graphics Plugin to the project:

In the Project panel, click the  tab.Effects

Navigate to , and drag the plugin onto the Video Effects > Vizrt > Graphics Plugin
transparent video clip in the Sequence panel.

Select the transparent video clip that holds the plugin.

Click the  tab in the upper left corner.Effect Controls

Navigate to , and click the r button that Graphics Plugin > Control Graphics Plugin Edito
appears.

From the dialog box that appears, click .Configure
The  then opens.Graphics Plugin configuration tool

Make sure that the  tab is selected.General
Select a Viz Engine:

Specific Viz Engine: Sets a Viz Engine connection.

Connection Broker: Sets a  connection.Connection Broker

Select a Media Sequencer.

Click  to confirm the settings and close the configuration tool.OK

See Also

Graphics Plugin Workflow with Adobe Premiere Pro

To configure the Graphics Plugin for Avid on a Windows machine using the configuration tool

Start the NLE system.

Create a  and add a video clip to the timeline.new project

On the  menu select  and .Tools Effect Palette Effect Editor
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In the , open the effect category named .Effect Palette Vizrt

Drag the  effect onto the timeline.GraphicsPlugin

In the , click the  button to open the Graphics Plugin configuration tool.Effect Editor Config
The  then opens.Graphics Plugin configuration tool

Make sure that the  tab is selected.General
Select a Viz Engine:

Specific Viz Engine: Sets a Viz Engine connection.

Connection Broker: Sets a  connection.Connection Broker

Select a Media Sequencer.

Click  to confirm the settings and close the configuration tool.OK

After the plugin is configured the first time, the configuration can be accessed by clicking the Graphics 

Plugin’s  button in the Effect Editor window. The  option is unavailable as long as no Viz Config Editor

Engine and Media Sequencer are configured using the Graphics Plugin configuration tool.

Note:

If all connections are good, the  button will appear, making either Viz Trio or Viz Pilot Editor
available for use. For more information on how to configure Viz Trio and Viz Pilot, read the Viz Trio 

and Viz Pilot user guides, respectively.

......................................................................................................................................................................

......................................................................................................................................................................

Note:

When working with the Graphics Plugin for Avid, an effect is not automatically re-rendered when 

changing the length of an already rendered effect. In order to re-render this, select Clear Renders at 

 from the context menu.Position

......................................................................................................................................................................
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To configure the Graphics Plugin for Quantel using the configuration tool

Start the NLE system; Quantel.

Add a clip to the timeline (the clip is added in layer 1).

Create a new layer (layer 2).

Make sure that the second layer is selected.

Make sure that the  tab is selected (lower left).Effects

Click the  button.Tracker > Qplugin

Click .Favorites > Vizrt > select > VizNlePlugin
The Graphics Plugin effect is then added to the second layer in the timeline.

In the Vizrt Editor that appears, click the  button.Viz NLE Config
The  then opens.Graphics Plugin configuration tool

Make sure that the  tab is selected.General
Select a Viz Engine:

Specific Viz Engine: Sets a Viz Engine connection.

Connection Broker: Sets a  connection.Connection Broker

Select a Media Sequencer.

Click  to confirm the settings and close the configuration tool.OK

4.5.4 Advanced Configuration of Windows-based Graphics Plugin Systems

This section explains how to set up a default configuration for all users of a computer by adding a master 

settings file.

......................................................................................................................................................................
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A master settings file is useful in large installations where a system administrator can collect common 

settings into a shared file, and have this picked up by all users on a computer or all users on a network (by 

putting the file on a Windows share). There is currently no facility in the config tool to edit such a shared 

settings file, but an advanced user should be able to get this to work by copying the %APPDATA%

 file that the config tool produces into the desired shared location.\Vizrt\VizNLE\vizplugin.xml

If a master settings file is loaded and a user settings file is loaded later, then the latter will take precedence 

in case of any conflicts. So if for instance the loglevel defaults to "none", and the master settings file sets 

the loglevel to "report" and the user settings file sets the loglevel to "extreme", then the value of "extreme" 

is the one that is respected by the Graphics Plugin. But if the master settings file sets the Viz Engine 

hostname, and the user settings file is silent on this point, then the Viz Engine hostname in the master 

settings file will be used.

Before loading the user settings, the master settings file is looked for and potentially loaded as follows:

The Graphics Plugin asks the Windows registry for the SettingsDir string in the registry path under 

the listed registry locations.

If the string is found, and its content turns out to be a path to a folder, then the filename vizplugin.

xml is looked for at that location.

If that file is present, it is loaded as a default configuration before loading the individual user settings 

file.

Registry paths:

4.5.5 Removal of Windows-based Graphics Plugin Systems

The Graphics Plugin is removed using Windows’ .Uninstall or change a program

To remove the Graphics Plugin for Adobe from a Windows machine

To remove the Graphics Plugin for Avid from a Windows machine

To remove the Graphics Plugin for Quantel

To remove the Graphics Plugin for Adobe from a Windows machine

Open .Uninstall or change a program

Select .Vizrt Graphics Plugin for Adobe

Click .Uninstall

Click  in the appearing confirmation dialog box.Yes

Host system Registry path

Adobe HKLM\SOFTWARE\[vizrt]\NLE\After Effects

Avid HKLM\SOFTWARE\[vizrt]\NLE\AVX2

Quantel HKLM\SOFTWARE\[vizrt]\NLE\Quantel

Edius HKLM\SOFTWARE\[vizrt]\NLE\EDIUS
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To remove the Graphics Plugin for Avid from a Windows machine

Open .Uninstall or change a program

Select .Vizrt Graphics Plugin for Avid

Click .Uninstall

Click  in the appearing confirmation dialog box.Yes

To remove the Graphics Plugin for Quantel

Open .Uninstall or change a program

Select .Vizrt Graphics Plugin for Quantel

Click .Uninstall

Click  in the appearing confirmation dialog box.Yes
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5 User Interface

This section describes the Graphics Plugin Editor and Graphics Plugin configuration tool interface. The 

configuration tool enables you to configure and tune the Graphics Plugin while using the NLE client.

All settings described in the following sections are valid for the latest version of the Graphics Plugin. For 

older versions, see available documentation for the version in question. Example settings are given where 

it is needed to illustrate how they are used.

This section contains information on the following topics:

Graphics Plugin Editor

Graphics Plugin Configuration Tool

Graphics Plugin Performance Tester

See Also

Viz Pilot User’s Guide

Viz Trio User’s Guide

Viz Pilot Edge User's Guide

5.1 Graphics Plugin Editor

This section describes the Graphics Plugin Editor’s interface (available for Mac users). If you are using 

Viz Pilot Edge or Windows with Viz Pilot or Viz Trio, please refer to the respective user guides.

This section contains information on the following topics:

Menu Options in Graphics Plugin Editor

Information Fields in Graphics Plugin Editor

Preview Settings in Graphics Plugin Editor
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5.1.1 Menu Options in Graphics Plugin Editor

The following menu options are unique to the Graphics Plugin Editor. Other options are generic options 

provided by the operating system.

Page

Save Page (Cmd+S): Saves a page back to the Media Sequencer.

Next tabfield (Cmd + Arrow Down): Selects the next tabfield.

Previous tabfield (Cmd + Arrow Up): Selects the previous tabfield.

Show

Import Trio XML Archive: Imports an exported Viz Trio archive. The import recreates the 

exported show on the connected Media Sequencer.

Note:
......................................................................................................................................................................
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5.1.2 Information Fields in Graphics Plugin Editor

The Graphics Plugin Editor supports the most common control properties; however, it is only possible to 

input text, change numerical values, select images, geometries, fonts and materials.

There is no support for input of boolean values, editing of lists and tables or scrolls. However, the editor 

can use and render Viz Trio pages made using a regular Viz Trio even though they have these field types.

5.1.3 Preview Settings in Graphics Plugin Editor

The following may be set for the preview:

Safe area: Shows the defined safe area configured by the current Viz Engine.

Title area: Shows the defined title area configured by the current Viz Engine.

Key: Shows the graphics’ key signal.

Bounding boxes: Shows the bounding boxes for the graphical elements in the scene.

5.2 Graphics Plugin Configuration Tool

This section describes the basic user interface that applies for the configuration tool’s General and 

Advanced tab.

Reset All: Resets all settings to default (factory settings).

Performance: Opens the performance tester for . See also Tuning the System Graphics Plugin 

.Performance Tester

OK: Saves the current configuration.

Cancel: Cancels all changes and closes the configuration tool.

Help: Opens this guide in a browser.

When performing an import you should always make sure that the scenes are available to the 

connected Viz Engine.
......................................................................................................................................................................
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Depicted above is the Windows-based configuration tool that describes the basic settings needed to 

connect to a remote machine running a multiplexed Viz Engine and a Media Sequencer as the “database”.

The following sub sections describe all user-configurable settings under the configuration tool’s Advanced 

tab. The tables contain information about valid values and what the settings are used for. Information 

about operating system specific settings are noted in the Description column.

This section contains information on the following topics:

Important Settings in Graphics Plugin Configuration Tool

Plugin Settings in Graphics Plugin Configuration Tool

Viz Engine Settings in Graphics Plugin Configuration Tool

Editor Settings in Graphics Plugin Configuration Tool

Object Store Image Search

Startup Variables

Shared System Settings

5.2.1 Important Settings in Graphics Plugin Configuration Tool

The Important settings view displays the most important settings needed in order to run the Graphics 

Plugin.
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Important settings

5.2.2 Plugin Settings in Graphics Plugin Configuration Tool

The Plugin settings view displays all settings that are separate and only in use by the Graphics Plugin, 

hence they are not application specific settings such as Viz Engine and Graphics Plugin Editor.

Plugin settings

Setting Description

Viz Engine host See the  Viz Engine Settings in Graphics Plugin Configuration Tool

section.

Use Connection Broker Enables use of the Connection broker, see .Connection Broker

Connection Broker host Sets the host of the computer running the Connection Broker, see 

.Connection Broker

Media Sequencer host Sets the host of the computer running the Media Sequencer service.

Plugin user interface See the  section.Plugin Settings in Graphics Plugin Configuration Tool

Viz Engine network 

compression

See the  Viz Engine Settings in Graphics Plugin Configuration Tool

section.

Viz Trio NLE host Defines the hostname of the machine running the Viz Trio NLE. 

Typically, this hostname is .localhost

Viz Pilot NLE host Defines the hostname of the machine running the Viz Pilot NLE. 

Typically, this hostname is .localhost

Tip:

These settings can be modified by selecting  from the drop-down list in the Important settings

Graphics Plugin configuration tool’s  tab.Advanced

......................................................................................................................................................................

......................................................................................................................................................................

Setting Description

Plugin anti-aliasing Determines whether requests for small frame sizes should be anti aliased 

on the Viz Engine.

Plugin color correction Enables broadcast-safe colors.

Set cap-601 to cap high and low values directly to get 16-235.

Set linear-cap-601 to perform a linear recalculation of the data to 16-235.

Default value is .None

Plugin field dominance In case the host application consistently reports a wrong field dominance 

to the plugin, it is possible to force the plugin to assume the field 

dominance which is correct. It will not override the host application when 

the host application states that there is no field dominance, but will 

override it when it does.
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Setting Description

Available options are: Autodetect (default), Lower field first and Upper 

field first.Limitation: Mac OS X only.

Plugin log directory Use this setting to override the default logging directory.

See the  section for more information on logging.Log Files

Plugin log level Set the log level in order to provide an error report to Vizrt. Set to 

"Report" the plugin will generate dated log files. See the  section Log Files

for more information on log file locations.

Only use it when it is specifically needed to make a report as it will slow 

the effect of the plugin.

The default directory where logs are saved can be overridden using the 

plugin log directory setting.

If set to , the plugin will only log errors, which is the default None

behavior.

If set to , the plugin will in almost all cases include enough Report

information in the log files to let Vizrt figure out the cause of problems.

If set to , the plugin will generate a very large amount of logging Extreme

information.

Options: ,_ Report  Extreme_.None and

Default value is .None

Plugin premultiply alpha Configures whether the plugin will pre-multiply alpha or not when 

rendering. In some cases, the Viz Engine has already multiplied the color 

channels with the alpha channel.

Plugin should log fields/frames Enables the plugin to dump all frames and fields it renders to the file 

system allowing the user and Vizrt support to identify issues related to the 

graphics. Files are dumped in a sub directory below the "Plugin log 

directory".

Plugin user interface Sets the interface to use for selecting graphics templates.

The plugin works with Viz Trio (default), Viz Pilot and Viz Pilot Edge.

Templates using the same scene but opened from Viz Trio, Viz Pilot or 

Viz Pilot Edge are different entities. Once an editor is set and used to add 

a graphic effect to the timeline the effect is also bound to that editor. To 

create an effect with a template from another editor the old effect must 

first be deleted, a new editor configured, and then a new effect created.

Limitation: Viz Trio and Viz Pilot are Windows only.

Tip:
......................................................................................................................................................................
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5.2.3 Viz Engine Settings in Graphics Plugin Configuration Tool

The Viz Engine settings view displays all settings relevant for Viz Engine.

Viz Engine settings

These settings can be modified by selecting  from the drop-down list in the Graphics Plugin settings

Plugin configuration tool’s  tab.Advanced
......................................................................................................................................................................

Setting Description

Use Connection Broker Enables the Graphics Plugin to connect to the Connection Broker for 

graphics rendering.

Connection Broker host Sets the hostname or IP address of the Connection Broker (see Connection 

).Broker

Viz Engine host Sets the hostname or IP address of the Viz Engine renderer.

Viz Engine network cleanup Sets the time for how long the plugin should wait after last use before 

considering tidying up loose connections to the Viz Engine.

Unless the actual use of the plugin has been measured, this should not be 

changed.Default value is .8m

Viz Engine network 

compression

Sets the compression to level.

No Compression for gigabit networks will send all frames across the 

network uncompressed.

PNG (Portable Network Graphics) is a lossless compression format.

RLE (Run-length Encoding) is a lossless compression format. RLE is only 

supported by Viz Engine 3.2.2. and later versions (see the Software 

 section).Requirements

It is recommended to use no compression on gigabit networks, and 

compressed formats on slower networks (e.g. 100mbit).Default value is 

.RLE

Viz Engine network timeout Sets the time for how long Viz Engine connections should wait for replies.

Unless network measurements for the Viz Engine have been performed, 

this setting should not be changed.Default value is .45s

Viz Engine prefetching Pre-fetching, also known as caching, greatly increases the rendering speed 

when using a start to stop rendering, like Pinnacle's yellow slices, or 

Avid's pre-render effect mode.

Failsafe mode is .off

Default value is .on

Viz Engine prefetch size
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5.2.4 Editor Settings in Graphics Plugin Configuration Tool

The different editor settings views display settings relevant for either the Graphics Plugin Editor, Viz Trio 

or Viz Pilot. Limitations are noted.

Editor settings

Setting Description

Use this setting to indicate how many frames or fields the plugin should 

pre-fetch. A higher number improves start to stop rendering (pre-render) 

performance but reduces the scrub performance.

Note that this option is only available if pre-fetching is enabled.

Default value is .20

Tip:

These settings can be modified by selecting  from the drop-down list in the Viz Engine settings

Graphics Plugin configuration tool’s  tab.Advanced

......................................................................................................................................................................

......................................................................................................................................................................

Setting Description

Drive remappings Semicolon-separated list of drive remappings used during import of Viz 

Trio shows. These will cause associated files of the specified file types to 

be unpacked to a different drive letter than stored in the *.trioshow file. 

Each mapping is on the form wildcard=driveletter.

Limitation: Only used by Viz Trio.

Executable Name of the editor's executable file. Can be changed in case another 

filename is in use than the usual.

Default values are  or .trionle.exe VcpAxNle.exe

Limitation: Windows only.

Grace period Sets the time for how long the plugin should give Graphics Plugin Editor 

to start everything without interruptions.

Default time is .2s

Host Sets the hostname or IP address of the machine running the Graphics 

Plugin Editor, Viz Trio or Viz Pilot.

Network timeout Sets the time for how long connections to Graphics Plugin Editor should 

wait for replies.

Unless network data for the Graphics Plugin Editor has been measured 

this should not be changed.

Default value is .90s
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5.2.5 Object Store Image Search

When using the , it is possible to set up an Object Store image search, Graphics Plugin for Final Cut

provided that an app server is set up.

To perform an Object Store image search

Create a sequence.

Add a clip to the sequence.

Drag the Graphics Plugin effect to the sequence.

Double-click the effect, and select the  tab at the top of the screen.Controls

Setting Description

VOS image search URI template for image search from Object Store, a component of Viz 

Pilot. This requires the Viz Pilot Data Server, introduced in Viz Pilot 5.6. 

Being a URI template means there should be a placeholder in the text you 

enter, indicated by curly-brackets, which gets replaced by specific search 

terms, as in this example: http://vcpserver.example:8177

}./vos/search?q=\{query

Limitation: Mac only.

Options The exact command line option(s) string that should be passed to the 

editor’s process at startup.

For more information on command line options, see the  Startup Variables

section.

Limitation: Only used by Viz Trio and Viz Pilot.

Shared folder Shared path used for temporary files during import of Viz Trio shows. 

Both the Graphics Plugin and the external Viz Engine should have full 

access to this folder.

Limitation: Only used by Viz Trio.

Shared folder for Viz Engine Shared path as seen from the Viz Engine machine, must refer to the 

previous setting. Only needed if the external Viz Engine uses a different 

path (e.g mapped network drive) for the same folder.

Limitation: Only used by Viz Trio.

Url Url to the Viz Pilot Edge app. This requires a Viz Pilot Data Server with 

Pilot Edge installed.

Limitation: Only used by Viz Pilot Edge

Tip:

The various editor settings can be modified by selecting  or Graphics Plugin Editor, Viz Trio NLE

_Viz Pilot NLE _from the drop-down list in the Graphics Plugin configuration tool’s  tab.Advanced

......................................................................................................................................................................

......................................................................................................................................................................
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From the  panel, click the  button.Controls Graphics Plugin Config

In the  window that opens, click the  tab.Graphics Plugin Configuration Tool Advanced

From the  list, click .Settings view All settings

Locate the , and set the path to your Object Store.VOS image search

Click the  button.OK

Back in the  panel, click the  button.Controls Graphics Plugin Editor

In the  window that opens, select a show and then a template containing Graphics Plugin Editor
an image field.

From the  list, select the field that contains the image.Information fields

From the window that opens, click the  tab.Search
Type a search string that matches your preferences in the search field.

From the list of images on your app server, select the one you prefer.

The image is being updated both as a thumbnail in the  list and in the preview Information fields
window.

Click the  button to return to the sequence view.OK

5.2.6 Startup Variables

Options are used as variables for the actual value set for the plugin. The options can be used as part of an 

editor’s startup options.

The following options are available and configurable:

MSE_HOST: References the active Media Sequencer host.

Example: -mse MSE_HOST

LOG_PATH: Refers to the currently used .Plugin log directory

Example: -logfile-path "LOG_PATH"

5.2.7 Shared System Settings

This section covers the shared settings feature that is available to Windows users in the system registry.

Note:

The startup options are only valid for NLE editors on Windows.

......................................................................................................................................................................

......................................................................................................................................................................
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Whereas the Graphics Plugin 1.3 setup file had a static placement for example under C:\Program 

, the new system stores the settings in a per-user directory, for example under Files C:\Documents 

. Placing the same file in a shared directory allows multiple users to use and Settings\<username>

a standardized setup overriding per-user settings.

By adding a Windows registry entry with a path to the , the settings in that file master configuration file

will take precedence over the default values for the various settings, but the individual settings that the 

user changes in the Graphics Plugin configuration tool will take precedence over the master configuration 

.file

Given a particular setting, the following rules apply:

If a setting has been set using the Graphics Plugin configuration tool, that value is used, otherwise

if it has a value in the master configuration file, that value is used, otherwise

the  value for the setting is used.default

To add a shared system setting

Start Graphics Plugin configuration tool.

Configure the Graphics Plugin using the configuration tool.

Save and exit the configuration tool.

Find the file  in the current user's  folder.vizplugin.xml Application Data

Copy the file to the designated shared location.

Set up the  registry entry to point to the shared directory location where the copied file SettingsDir

was placed.

Note:

The shared setting does not apply for Mac users.

......................................................................................................................................................................

......................................................................................................................................................................

HKEY_LOCAL_MACHINE/SOFTWARE/[vizrt]/NLE/AVX2/SettingsDir
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5.3 Graphics Plugin Performance Tester

With the Graphics Plugin for Windows and Mac there is a small performance tester tool available for 

testing various configurations. The tool will test the plugin directly and how it performs on the network 

and how quickly it returns graphics to the NLE system.

It will not test the time it takes to fill the NLE system's frame buffer or the time the NLE system uses 

between each request for frames to the NLE system. Hence, it is recommended to test the NLE system 

once the Graphics Plugin is tested and found to be working satisfactory.

The performance tester tool tests the rendering, network speed and how long it takes before the plugin 

delivers a frame to the NLE system, that is the raw speed of the plugin.

Results table: Shows a table of results displaying the protocol tested, prefetch size, time and frames 

per second achieved.

Viz Engine: Sets the Viz Engine host to be used for testing.

Image protocol: Sets the parameter for how to transfer the graphics over the network. Select one or 

multiple options.

Prefetch size: Sets the pre-fetching that will be tested. Available options are 5, 10 or 20 frames or 

fields.

Scene name: Sets a particular scene that can be loaded and tested (e.g. ).02_GFX/VizNLE/1000
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Clip length: Sets the length of the clip that is to be rendered. 5 or 10 seconds are good starting points 

to check the rendering time.

Pause time: Sets the pause in milliseconds between renders, that is the time that an NLE system uses 

to process the previous data. This would be set much lower for SD than for HD. It is recommended 

to try other values between 0 and 100 ms+ to see how this affects the network use. For more 

information, see the  section.Tuning the NLE System

Run tests: Tests the current settings configured for the plugin with the clip length and pause options 

set. This is useful when performing tests with concurrent users.

Video mode: Sets the Viz Engine video mode to either:

1080i 50 FPS

1080i 60 FPS

720p 50 FPS

720p 60 FPS

PAL

NTSC

Test summary: Shows a report of problems and various statistics.

Once the settings that give the optimal results are found they can be set in the Viz configuration tool 

manually such that the settings can be tested with the actual NLE system as well.

See Also

Tuning the System
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6 Tuning the System

The Graphics Plugin is a fairly complex product that involves several applications communicating over a 

network. These applications need to be individually robust and the communication between them equally 

robust.

The first step of any installation is to see that everything works fine; hence, the plugin will in most cases 

work out of the box. After everything is working, the next step is to configure it to work reliably in the 

work environment it is used which for many is a non-trivial task.

This section contains information on the following topics:

Introduction to Tuning the NLE System

File Compression

Prefetching

Concurrent Graphics Plugin Users

System Processing

See Also

Graphics Plugin Performance Tester

6.1 Introduction to Tuning the NLE System

The Graphics Plugin is designed to give the NLE system direct access to preview, edit and apply graphics 

to the NLE project and consequently onto the video on the timeline. In addition the Graphics Plugin is 

designed around the concept of one renderer being shared by several concurrent users on a fast network. 

The complexities of this design is hidden from the normal user and to a certain extent to the system 

administrator. Hence, there are multiple challenges with this approach when effects are rendered.

The following can be described as a common workflow for most NLE systems:

The NLE system (Final Cut Pro, Avid Media Composer and others) demands a frame or field from 

the Graphics Plugin.

The Graphics Plugin checks its configuration and tries to connect to Viz Engine over the network.

When connected, the plugin will query Viz Engine for basic information, load the graphical scene in 

question and set the correct values in the scene, and stretch the graphics to fit the effect in the NLE 

project.

The plugin will then start requesting fields and frames from Viz Engine depending on what the NLE 

system has requested.

Viz Engine will receive the requests and ensure that the right scene is loaded and move to the right 

frame or field and grab the graphics and send them back over the network.

Graphics Plugin will receive the graphics and hand them back to the NLE system.

The NLE system will process the data it received before requesting more graphics, thus repeating the 

steps above.
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The procedure described above is simple to follow, it works fine and is easy to test. The problem with it is 

that it is not very fast. The most obvious problem is that NLE systems ask for a simple frame or field at a 

time and blocks until it gets a reply. The Graphics Plugin sends the request to Viz Engine and has to wait 

for a reply before it replies back to the NLE system.

The first concern is the amount of data being sent, for example a simple interlaced HD (1080i) field with 

full alpha is 4MB (1920*540*4 bytes) in size which will take some time to transmit. To render a 5 second 

interlaced HD clip at 50 frames a second means that more than a gigabyte of raw data has to be rendered 

and then processed by Viz Engine, sent over the network, received by the Graphics Plugin, and then 

moved into the buffers provided by the NLE system whereupon the NLE system needs to process the 

gigabyte of data.

Every network also has latency and is affected by other traffic on the network. Waiting for every request 

returning with 4MB of graphic will take time, and then waiting for the NLE system to process it further 

also means that there is a lot of inactivity. Therefore, the Graphics Plugin has a goal of whenever the NLE 

system asks for a frame or a field it will have it ready to cut the delay. The plugin tries to accomplish this 

by keeping the network and Viz Engine continuously busy. It will try to predict what the NLE system will 

ask for next by asking Viz Engine in advance for graphics. Once Viz Engine has received the request it 

will render the graphics, have it sent back to the plugin which will process it to fit the format of the NLE 

system and have it ready.

To keep this workflow going there are a number of factors affecting it:

What tv-standard to use, for example PAL is a lot smaller than 1080i and will be quicker to render, 

process and send over the network.

The CPU and GPU of the Viz Engine defines how fast it can deliver graphics. As always, a better 

graphics card, faster CPU and more memory will help.

The network card on Viz Engine and the NLE client machine.

The network capacity defines how much data can be sent over the network.

The compression of the data decides both how much CPU is used on Viz Engine to compress and on 

the client to uncompress, as well as how much data is sent over the network.

The amount of ask-in-advance requests keeping the renderer and the network busy.

The processing the NLE system needs to do with the data it receives (affected by CPU and/or GPU, 

memory, software and so on).

Some things can be improved by adding hardware to the renderer and the clients, and by using as fast a 

network as possible. Other things, such as  ,  and File Compression Prefetching Concurrent Graphics Plugin 

 , can be configured, either by the plugin or by convention. In addition the processing done by the Users

NLE system will have a great impact on the performance as well.

See Also

System Processing

6.2 File Compression

Currently the Graphics Plugin supports two different types of compression as well as sending 

uncompressed data.
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The following options are available:

No compression (raw)

Benefit: No CPU spent on the renderer to compress and no CPU spent on the client to 

decompress. Usually very good for SD on good networks. Very good on clients with weak CPU 

and a good network card.

Problems: For HD the amount of data is large, and it will typically take longer to transfer over 

the network than compressed alternatives and it will use a lot of network capacity.

Portable Network Graphics compression (PNG)

Benefit: Compresses graphics very well. On very slow networks this compression will have a 

very small footprint, which is useful for example over a Digital Subscriber Line (DSL) 

network, 10Mbit networks or district offices rendering on a renderer in a central office.

Problems: Can use a lot of CPU to compress and decompress, which will be a problem on 

slower computers. Generally outperformed by the other two options and mostly useful for 

special cases.

Run-length Encoding compression (RLE)

Benefit: Compresses graphics well. Is easy and fast to compress and decompress. Uses a small 

fraction of the space for a 1080i field compared to no compression so network footprint is quite 

good. For HD on fairly updated computers it will often perform best. Also does very well on 

100Mbit networks. Has special handling that exploits the nature of TV-graphics and NLE 

graphics which contain bigger open areas, for example lower thirds, over the shoulders, and so 

on.

Problems: Uses CPU on the renderer and the client, so less powerful machines might get better 

performance with no compression. The smaller amounts of data with SD negates some of the 

compression benefits, but can often be best for SD too. Might not give much benefit if there are 

big horizontal gradients.

Experience when testing in a lab has shown that the general advice above will not always hold, and only 

on site testing will tell what works best for a given network.

6.3 Prefetching

As explained, in the  section, the Graphics Plugin will try to guess what the NLE system File Compression

will ask for next and ask for the frames and fields from the renderer in advance. It is possible to disable 

this feature but this will be the safe mode described earlier and is only for use if there are problems with 

the pre-fetching.

When tuning the performance, the question is how aggressive the pre-fetching should be. The current 

releases use more aggressive pre-fetching than earlier, so the key thing is to configure how many fields to 

pre-fetch, that is, how many graphics requests should be on the network from one client at any given 

moment. It is also an option to ask the system to pre-fetch the whole clip, and it would probably give a 

reasonable performance; however, this will block the Viz Engine for other users who want to edit their 

effects, scrub the timeline or render. In general the default setting of pre-fetching 20 fields is a good 

compromise, but the setup might require a different value and anything between 5 and 30 are acceptable 

values.

See Also
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File Compression

6.4 Concurrent Graphics Plugin Users

The Graphics Plugin has been designed for several users editing, scrubbing the timeline and rendering at 

the same time. And the users should have a responsive system and they all need to have their own state on 

the Viz Engine. Viz Engine has its own built-in multiplexer functionality.

When tuning performance it is important to take into account that testing on a single machine will not give 

the full answer as to how it will be when all machines are working at the same time. In a video editing 

environment one can also assume that big video files are also transferred over the network taking up a 

certain amount of the network capacity. The  will only test speed for Graphics Plugin performance tester

one user, so the real test is to test with several users after things are ok for a single user.

See Also

Graphics Plugin Performance Tester

6.5 System Processing

One thing that we have seen is that despite an optimally configured Graphics Plugin, users still might have 

performance problems. One important factor is the size of the project. One can safely assume that working 

on a fully interlaced HD (1080i) project will use more resources than PAL or NTSC.

When there is a mismatch between video size and the timeline/project settings, the NLE system might 

need to rescale graphics and video which is a costly process. Rendering on a video that resides on a shared 

drive on the network will also steal valuable network capacity.

Consider the following case; An interlaced HD project with a well-configured Graphics Plugin has an 

effect added to a layer above the video, and rendering is started. The following will happen;

The NLE system asks for a frame,

receives it from the Graphics Plugin,

and processes the graphics and possibly caches the data on disk.

These steps will then be repeated for each frame. Steps 1 to 2 might only take 20 milliseconds (ms); 

however, the time from 2 to 3 can be as much as 600-1000 ms. So ensuring that the video size, format, 

project, and timeline settings correspond with each other, and that rendering is done locally on a fast disk 

helps a lot. Although the performance analysis reports all things as good, the system as a whole might be 

slow due to slow hardware on the NLE system.
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7 Scene Design

When designing scenes in Viz Artist that is to be used together with the various , Supported NLE Systems

it is important to follow specific design conventions, in order for the output to render correctly.

The following notes must be taken into consideration when designing for the Graphics Plugin workflow:

Key

Stop Points

Stretching Stop Points

Directors and Stop Points

Sound and Stop Points

Video and Stop Points

Effect Plugins

Transition Logic

Lift and Extract

7.1 Key

When designing a scene that is to be used in the Graphics Plugin workflow, a  signal must be added to key

the scene, in order for the graphics to blend correctly with the video.

The key signal can be created by adding the Key plugin to one or more containers in the scene, or by 

enabling Auto Key under the global scene settings.

7.2 Stop Points

When designing a scene that is to be used in the Graphics Plugin workflow, one or more  stop points

should be added to the directors at the root level of the Stage.

In a scene that contains only one stop point, the in-animation takes place on the left side of the stop point 

in the Stage, while the out-animation is visualized on the right side. The stop point will automatically be 

converted to a pause point, and if needed, stretched, to make the entire animation (in, pause, and out) 

match the length of the graphics element in the NLE timeline.

7.3 Stretching Stop Points

The stop points in a scene will automatically be stretched, in order for the animation to match the length of 

the graphics element in the NLE timeline.

As an example, imagine having an in-animation of 3 seconds and an out-animation of 4 seconds. If the 

animation is stretched to 10 seconds in the NLE timeline, the in-animation will be shown for 3 seconds, 

followed by the stop point between the in- and out-animation that will be stretched to 3 seconds, and then 

the out-animation will be shown for 4 seconds, totaling to 10 seconds.

In another example, if the animation above is shortened to 5 seconds, it will show the in-animation for 3 

seconds, skip the pause point, and then cut the out-animation down to 2 seconds.
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When using multiple stop points, the length of the stretching will be divided evenly across the stop points. 

Note that in the NLE workflow, it is not possible to adjust the length of the various stop points. Again an 

example, so if the animation contains two stop points and is stretched to 17 seconds, then the in-animation 

will be shown for 3 seconds, the first stop point for 5 seconds, the second for another 5 seconds, and then 

finally the out-animation for 4 seconds.

7.4 Directors and Stop Points

Stop points that are used to pause and stretch animations, must be placed in directors at the root level of 

the Viz Artist Stage. Stop points that are placed in sub-directors (not at the root level), will be ignored by 

the NLE system.

Animations that are paused and stretched must also be placed in directors at the root level of the Viz Artist 

Stage. Any animations in sub-directors will not be stretched, hence looping background animations and 

similar should be placed here. These animations will be played out continuously, regardless of the stop 

points in the root containers.

7.5 Sound and Stop Points

There is no support for embedded sound effects in graphics being used in the Graphics Plugin workflow. 

Sound that is embedded together with graphics is based on the timeline used for the graphics, and there is 

no good and general way of stretching sound.

7.6 Video and Stop Points

Through the use of various Viz Artist plugins, such as , it is possible to play media files or streams MoViz

as part of the output of a graphics scene. Note that the video will be stretched according to the length of 

the graphics clip in the NLE timeline.

7.7 Effect Plugins

Effect plugins, such as , works in such a way that particles are emitted from a certain point, and RFxSmoke

then moved in a random order in some direction until they eventually fade away. The output of this 

random particle movement may be distorted when played out as part of the Graphics Plugin workflow. 

Hence, it is recommended to use such effects with caution when designing for NLE.

7.8 Transition Logic

The Graphics Plugin workflow makes it is possible to work with  scenes, with certain Transition Logic

limitations.

Following the normal workflow of the supported NLE systems, the graphics templates can be modified 

and sent to air. A template that contains multiple elements, such as a banner, logo, and a lower third, can 

be animated to the various in and out states, so that it matches the timing of the graphics event in the 

timeline.

The following limitations apply to Transition Logic scene design:
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There is  for graphics that are dependent on states of other graphics elements. For no support

example, a normal Transition Logic scene can be designed to have a logo taken on air in the lower 

part of the screen, and then when a lower third is taken on air, the logo should shift to the upper part 

of the screen. To achieve this type of behavior; create a combination template, using Viz Trio or Viz 

Pilot’s Template Wizard, to control the required layers, such as bug, clock, lower third, OTS, and so 

on.

There is  for multiple graphics stacked together, so-called  or  no support in-to-in back-to-back

animations. For example, when showing two instances of a lower third straight after another on the 

timeline, it is not possible to keep the backplate from object number one, and simply update the 

editable variables, in this case the name of the interview objects. Instead, the first element must be 

animated out, and then the second one in.

See Also

Viz Artist User’s Guide’s sections about Transition Logic

Viz Trio User’s Guide’s section about Combination Templates

7.9 Lift and Extract

When using Viz Pilot as your Editor, Lift and Extract allow you to remove a portion of a clip from the 

timeline. This is usually set by the mark-in and mark-out points.

Lift will remove a portion of a clip, while leaving the interval duration between the mark-in and 

mark-out points.

Extract will remove a portion of a clip, but does not leave the interval (cutting the portion of the clip 

out completely)

Although Lift and Extract modify the clip, no frames in the graphic are skipped. The portions of the clip 

before mark-in and after mark-out are separate entirely, and the graphic will also be split.
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8 Troubleshooting, Logging and Reporting

The following sub sections describe how to report problems to Vizrt, how to log Graphics Plugin activities 

and lastly a section on common questions and answers.

This section contains information on the following topics:

Reporting Problems

Log Files

Questions and Answers

8.1 Reporting Problems

The Graphics Plugin is (despite the simple interface) a complex integration of several products with a 

number of things that can go wrong. The Graphics Plugin is hiding most of this complexity for the users 

and to a certain extent also to people who set things up.

When there is a problem it might be hard to provide the right information to Vizrt Support in order to 

track down the problems. This section is a step-by-step guide for how to report problems.

This section contains information on the following topics:

Before Reporting Problems

Reporting a Problem

8.1.1 Before Reporting Problems

Read the Graphics Plugin Administrator's Guide

Read the Graphics Plugin Release Notes

Check that things were configured the way they were meant to

Note:

All problems should be registered with Vizrt’s Customer Portal, or if your company does not have 

access to the portal a report should be sent to a local Vizrt representative or directly to support@vizrt.

com.

......................................................................................................................................................................

......................................................................................................................................................................

Note:

Check that the hardware specified and the tested and recommended versions of Viz Engine are used.

......................................................................................................................................................................

......................................................................................................................................................................

Note:

The plugin depends very much on the Viz Engine being configured for it; hence, it should only be 

used by NLE users.

......................................................................................................................................................................

......................................................................................................................................................................
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1.  
2.  
3.  
4.  
5.  
6.  

8.1.2 Reporting a Problem

When filling out a report please add as much information as possible. All reports should ideally contain 

what is described in the  section, and in addition logs and information about how to Content of the Report

reproduce the problem for the specific Graphics Plugin installed.

This section contains information on the following topics:

Content of the Report

To make a report for the Graphics Plugin using Avid Media Composer

To make a report for the Graphics Plugin using Final Cut Pro

Content of the Report

The report should contain information about the following topics; Problem description (as detailed as 

possible), logs, software and hardware, setup, graphics and network.

See the following sections on how to make reports for different versions of the Graphics Plugin.

Problem description: Include a good description of what the problem is and how to reproduce it. 

Remember to use simple English.

Discern different components, for example when clicking Edit in the NLE system an editor is 

started (Viz Trio, Graphics Plugin Editor for Mac and so on).

Add screenshots and illustrations that will simplify the message.

Logs: Create a log where the problem, and only the problem, has been reproduced. This is essential 

for tracking down things and ruling out problems. For more information, see the  section.Log Files

Software and Hardware: Add exact versions of software (build number) and hardware used.

Graphics Plugin (installer) as well as system type (Windows/Mac versions) it is installed on 

(including hardware and important service packs)

Viz Engine (and hardware, if it is a standard PC or has SDI)

NLE system used, and information about project settings, as well as any special things in the 

project that might make sense (GPU effects, transition effects, video size not same as project 

setting, and so on.)

Editor used, for example, Viz Pilot, Viz Trio or Graphics Plugin Editor.

Setup: Describe differences in the installation, if any, from the recommended setup.

Graphics: Include scenes that work and do not work, and add information about what has been 

tested (for example if key is ok or not).

Network: Add a description of how the network, bandwidth, routers, and switches are configured.

To make a report for the Graphics Plugin using Avid Media Composer

Start Avid.

Click  on a Graphics Plugin effect.Config

Go to Plugin settings and find Plugin log level, and set it to .Report

Close the configuration tool.

Close Avid.

Open  at the default Graphics Plugin log directory.Windows Explorer

......................................................................................................................................................................
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6.  

7.  
8.  
9.  

10.  

1.  
2.  
3.  
4.  
5.  
6.  

7.  
8.  
9.  

10.  

Move all log files to a new directory. The log folder should be empty.

Start Avid and reproduce the problem.

Close Avid after reproducing the problem.

Store the files that were created in  somewhere safe and %APPDATA%/Vizrt/VizNLE/Logs

attach them to the appropriate .support case

To make a report for the Graphics Plugin using Final Cut Pro

Start FCP.

Click__  on a Graphics Plugin effect.Graphics Plugin Config

Go to plugin settings and find logging, and set it to .Report

Close the configuration tool.

Close Final Cut Pro.

Open Finder at Home > Library > Logs > VizNLE

Move all files to a new directory. The log folder should be empty.

Start FCP and reproduce the problem.

Close FCP after reproducing the problem.

Store the files that were created in  somewhere safe Home > Library > Logs > VizNLE

and attach them to the appropriate .support case

See Also

Log Files

8.2 Log Files

Logging is performed by the Graphics Plugin, and the different applications that the Graphics Plugin 

integrates with. The following paragraphs describe the different log files, their log levels, and where they 

are stored.

The Graphics Plugin generates log files that are located in the directory specified by the Graphics Plugin 

(see below).

The Windows-based log files are placed in the following directory;

%APPDATA%/Vizrt/VizNLE/Logs

viznle-log-< >.txtdate_time

nleconfig-< >.txtdate_time

vcp_ax_nle.log

trio-< >.logdate_time

Note:

The default Graphics Plugin log directory is . The log %APPDATA%/Vizrt/VizNLE/Logs

directory can be modified from the  for Windows, see the Graphics Plugin configuration tool

illustration above.
......................................................................................................................................................................

Note:
......................................................................................................................................................................
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The Mac-based log files are placed in the following directory;

~/Library/Logs/VizNLE/

viznle_log--< >.txtdate_time

VizNLEConfig--< >.logdate_time

VizNLE_Editor--< >.logdate_time

The Graphics Plugin related log files, including Viz Trio and Viz Pilot log files, are by default placed at %

.APPDATA%/Vizrt/VizNLE/Logs

The location of the Graphics Plugin log files can be modified from the Graphics Plugin configuration tool, 

under the  view. The text in the  box defines the folder where the log Plugin settings Plugin log directory

files should be placed. To define a new folder for the log files, type a new path in the text box.

The path for the Viz Trio and Viz Pilot log files can be modified from the Graphics Plugin configuration 

tool, under the and   settings view respectively. By default, these log files are Viz Trio NLE  Viz Pilot NLE

defined to be put in the same folder as the Graphics Plugin specific log files, by using the -logfile-

 command in the options text box (  refers to the Plugin log directory path LOG_PATH LOG_PATH

setting).

The log directory can be modified from the  for Windows.Graphics Plugin configuration tool
......................................................................................................................................................................
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To place the Viz Trio and Viz Pilot log files in a folder separate from the Graphics Plugin log files, 

replace  in the options text box with a folder name.LOG_PATH

See Also

Editor settings

Plugin settings

8.3 Questions and Answers

This section contains a mix of troubleshoot and frequently asked questions, and will try to answer 

questions that may arise when using the Graphics Plugin. Differences between the Mac and Windows-

based versions are noted where needed.

This section contains information on the following topics:

General

Using the NLE System

Note:

Plugin log directory does not apply for Graphics Plugin Editor.

......................................................................................................................................................................

......................................................................................................................................................................
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Configuring the NLE System

Tuning the NLE System

Rendering with Viz Engine

Configuring Graphics Cards

8.3.1 General

How do I contact Vizrt with my Graphics Plugin questions?
Before a question is forwarded, please read the questions and answers that are given in the 

sections below. For problem reporting, see the  section.Reporting Problems

Why are my start, stop and continue buttons in Viz Trio disabled?
When using an external Viz Engine, the start, stop and continue buttons in Viz Trio are 

disabled. This is the same for the Restart Viz Engine option that is available from the context 

menu in the Render window.

8.3.2 Using the NLE System

Which video editing software works with the Graphics Plugin?
See the  section.Supported NLE Systems

Why am I seeing double-sized graphics?
There is a difference between broadcast and consumer resolution. Several of the plugins are 

confused by for example consumer HD, producing graphics of the wrong sizes. If the camera 

says 1080i and has a resolution of 1440x1080 or 1280x1080 it is consumer HD as opposed to 

broadcast HD of 1920x1080.

Check that the software versions are correct. For details, see the Requirements and 

 section.Recommendations

I have edited and saved a scene but I cannot see the graphics on the video. Why is this?
When editing a scene in Viz Trio, Viz Pilot or the Graphics Plugin Editor, select to see the 

scene with  turned on (available above the renderer window). If the scene goes black, there key

is a design flaw in the scene. Redesign the scene by adding key to it. For details, see the Scene 

 section.Design

Why does the preview in Viz Pilot only display VPreviewPanel?
This might be a network bandwidth problem. In most cases this happens when the Graphics 

Plugin’s compression is set to No Compression and there is a bandwidth mismatch between Viz 

Engine and the NLE machine. Usually this happens when for example the NLE machine is 

connected to a 1Gbps network and the Viz Engine is connected to a 100Mbps network.

Try to set compression to  or configure both machines to use the same PNG Compression

network with the same bandwidth. Remember to check that the network cards are compatible 

with the network it is connected to.

Viz Engine should ideally be connected to a fast network. If the NLE machine is connected to a 

slower network it should work fine.

Note:

Recommended bandwidth for No Compression is 1Gbps.

......................................................................................................................................................................

......................................................................................................................................................................
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How do I set Viz Pilot’s preview aspect ratio?
The preview aspect ratio is set in Config’s  section (Viz Engine’s configuration Output Format

tool).

Why is Avid locked while using the Graphics Plugin?
The architecture of Avid and most NLE systems is that they block whenever a plugin is 

executing, which includes when the user has pressed Edit, the editor is open and the plugin is 

waiting for a response.

Why are the Graphics Plugin editors and configuration programs not closed when the NLE 
system is closed?

The NLE system is unable to handle a shutdown of the plugin itself (see previous question).

If the NLE system is accidentally terminated or closed this might cause the plugin process to 

still be running, and a manual and forced shutdown of the plugin is necessary. The latter can be 

obtained by restarting Avid or using the Task Manager.

8.3.3 Configuring the NLE System

Which ports are used in a typical installation?
See .Port numbers

On a Windows system, how do I configure the Viz Engine host and port?
For details about installing Viz Engine, see the  section.Graphics Rendering

On a Windows system, how do I configure the output from the Viz Engine?
Some settings related to the output from the Viz Engine are configurable. For example the 

image compression protocol ( ).No, PNG or RLE

If some of the Viz Engine settings are incorrect the preview will be disabled, and a message 

giving the reason will be displayed. Cases can be if the host is not found, cannot connect to the 

port, and so on. In addition if the Viz Engine connection is lost during runtime, the user will be 

notified.

On a Windows system, how do I configure the user interface that the Graphics Plugin should 
use?

Open the Graphics Plugin configuration tool and set the  setting and set it Plugin user interface

to Viz Pilot or Viz Trio.

The setting ensures that the NLE application will send the extra data that the user interface 

needs. This includes, but is not limited to, the scene length in milliseconds.

All user interfaces will show an error message in case the NLE system is not configured 

properly. The log files will also show warnings for non-critical problems.

See Also

Graphics Rendering

Note:

Some GUI settings are only valid for Windows-based NLE integrations using Viz Trio and 

Viz Pilot.

......................................................................................................................................................................

......................................................................................................................................................................
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Port Numbers

8.3.4 Tuning the NLE System

How can I find out how much time is used between each call from the NLE system to the 
plugin?

Empty the log directory, and start a project, make an effect, render it and exit the NLE system. 

Go to the log directory (see the  section) and run the following command:Log Files

Disregard the first few numbers and you might find for example:

See Also

Log Files

Tuning the NLE System

8.3.5 Rendering with Viz Engine

Which Viz Engine version should I run for HD?
A standard-PC version for all HD output is recommended due to a number of issues in the 

INCA version.

Can I include Datapool in the Graphics Plugin workflow?

grep --binary-files=text PERFORMANCE viznle-log*.txt

14:42:03 [T:2689318816] [/Users/<username>/fcp-1.0/plugins/fcp
/VizNlePlugin.mm,876] QUEUE PERFORMANCE: Time between renders 
397 msecs. 
14:42:03 [T:2689318816] [/Users/<username>/fcp-1.0/plugins/fcp
/VizNlePlugin.mm,876] QUEUE PERFORMANCE: Time between renders 
170 msecs. 
14:42:03 [T:2689318816] [/Users/<username>/fcp-1.0/plugins/fcp
/VizNlePlugin.mm,876] QUEUE PERFORMANCE: Time between renders 
394 msecs. 
14:42:04 [T:2689318816] [/Users/<username>/fcp-1.0/plugins/fcp
/VizNlePlugin.mm,876] QUEUE PERFORMANCE: Time between renders 
161 msecs. 
14:42:04 [T:2689318816] [/Users/<username>/fcp-1.0/plugins/fcp
/VizNlePlugin.mm,876] QUEUE PERFORMANCE: Time between renders 
157 msecs. 
14:42:04 [T:2689318816] [/Users/<username>/fcp-1.0/plugins/fcp
/VizNlePlugin.mm,876] QUEUE PERFORMANCE: Time between renders 
411 msecs. 
14:42:04 [T:2689318816] [/Users/<username>/fcp-1.0/plugins/fcp
/VizNlePlugin.mm,876] QUEUE PERFORMANCE: Time between renders 
161 msecs.



76

When including the Datapool mechanism in the Graphics Plugin workflow, you are always 

working on a scene-copy. The built-in multiplexer functionality of Viz Engine will rewrite 

references to  to the scene-copy you are using. This means that if your scene has RENDERER

DataActions that refer to , they will not be rewritten to the right scene, and they will RENDERER

fail fairly often. Referring to  will most certainly also not work.$SCENE

See Also

Graphics Rendering

8.3.6 Configuring Graphics Cards

How do I configure my NVIDIA card with Avid and Graphics Plugin?
From Avid’s release notes: “In the Open GL Settings tab of the Windows Display Properties 

dialog box, the Multi-Display hardware acceleration should be set to Single Display mode. The 

default setting is Multi-Display Performance mode. This is the mode that appears if a new 

version of the NVIDIA driver is installed. If the setting is anything other than Single Display 

”mode, the Avid application might drop frames during real-time playback of 3D effects.

See Also

Graphics Rendering
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